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Flying Faders and Microsoft Windows
Flying Faders operates in a  graphics environment called Microsoft Windows, created by Microsoft Corporation. An extension of the MS-DOS 

operating system, Microsoft Windows gives a  standard look and feel to Flying Faders and all other Windows applications.
The Flying Faders package contains all the software necessary to run Flying Faders. You can also run Flying Faders under Microsoft 

Windows version 2.0 or higher
With Microsoft Windows, you can take advantage of these additional features of the Windows environment

-Running multiple applications: You can run several applications under Windows at one time and easily switch between them, creating 

an integrated work environment
-Data exchange between applications: You can transfer data between Flying Faders and other standard DOS applications as well as 

other Windows applications.
-Windows control of the DOS environment From the Windows environment you can easily access all Windows and non-Windows "
applications, files, directories, and disks, and control all DOS-related tasks such as directory or file management and formatting disks.

To run Flying Faders under Microsoft Windows, you need to license and install Microsoft Windows version 2.03 or higher.
The above text is a  Microsoft(c) Windows licensing requirement and may be ignored by Flying Faders users who don't wish to license 

Microsoft Windows.
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Safety Notice

Flying Faders Optical Transmitter

The Flying Faders computer and console rack are both fitted with an intense optical 
transmitter (LAI 5001). The data sheet for the device states:

WARNING:

WHEN VIEWED UNDER SOME CONDITIONS, THE OPTICAL PORT OF THE 
TRANSMITTER MAY EXPOSE THE EYE BEYOND THE MAXIMUM 
PERMISSIBLE EXPOSURE RECOMMENDED IN ANSI Z-136-1,1981. UNDER 
MOST VIEWING CONDITIONS THERE IS NO EYE HAZARD.

DO NOT STARE ALONG THE AXIS OF THE OPTICAL PORT WHEN THE 
TRANSMITTER IS ACTIVE AND THE OPTICAL CABLE IS DISCONNECTED.
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INTRODUCTION

Flying Faders was created to be as unobtrusive as possible. The 
system was designed with a human interface that allows you to 
create a mix with minimal contact with the computer. There are no 
commands to memorize, because the system is controlled by a 
pointing device and dedicated keys. The on-line help is substantial 
enough that new users can perform most functions without looking 
at the manual at all. For those of you who like to experiment first 
and read the manual later (if at all), we suggest that you at least 
read the first chapter.

Our design goal for this manual (as well as for the entire Flying 
Faders system) is to keep everything as simple and as friendly as 
possible. This isn’t the most entertaining text to read (we’ve edited 
out all the jokes, insults, and family vacation stories), but by using 
“minimalist” writing, we hope that this can serve as a reliable refer­
ence.
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MANUAL FORMAT
With the exception of chapters 1,2, and 3, and 11, this manual 
uses the main screen menu and menu titles as an outline. The 
chapter structure consists of an explanation of each command, 
followed by access and operating instructions for that command. If 
the command accesses a dialog box, descriptions of each section 
of the dialog box and its operation are given.



Chapter 1: Introduction To Flying Faders -includes instructions 
for creating a mix, explains automation memory, and shows you 
how to choose Mix/Pass numbers.

Chapter 2: Fader, Mute and Channel Button Modes -discusses 
the functions of buttons and LEDs on the Global Master and indi­
vidual channels, explains groups and links, and contains informa­
tion on recording modes.

Chapter 3: Flying Faders Computer -explains the computer, how 
to operate the mouse/trackball and keyboard, Microsoft Windows, 
and accelerator key functions.

Chapter 4: System Menu -discusses commands in the System 
Menu and lists procedures for using each command. This chapter 
covers various “housekeeping features”.

Chapter 5: Mix Menu -informs you of commands in the Mix Menu 
and lists instructions for using each command. Chapter 5 includes 
the use of mix and channel editing features as well as saving and 
loading Mixes to and from disk.

Chapter 6: Options Menu -discusses commands in the Options 
Menu and lists the procedures for using these commands (pro- -s>
gramming Smart Keys, Safety Nets, Glide rates, timecode and 
screen options, and using Text Pages).

Chapter 7: Transport Menu -explains the different features asso­
ciated with the tape transport (setting transport times, selecting the 
transport, auto record on/off, resetting the transport controller, 
etc.).

Chapter 8: Lists Menu -shows you how to access and use the 
lists that are used throughout Flying Faders (Label List, Event 
Lists, etc.).

Chapter 9: Gangs Menu -is used for Coalescing and Suspending 
groups, and for deleting groups and links.

Chapter 10: Disk Menu -is used for carrying out disk manage­
ment routines to hard and floppy disks.

Chapter 11: Help Menu -contains the Help windows and Undo.

-fk
Chapter 12: Glossary -contains definitions of terms used in this 
manual.
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OVERVIEW OF 
FLYING FADERS

* If you don't want to write data on faders immediately, but wish 
to write mutes first, press the Trim button on the Global Master. 
With Trim enabled, no preset will be taken and faders will not be 
written to.
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MAKING A SIMPLE MIX
Note................ If Flying Faders is not powered up, refer to Chapter

3, “Turning on Flying Faders”.

1. Click on theOptions title in the menu bar at the top of the Flying 
Faders main screen.

2. Click on theTimecode Options title in the Options menu.

3. Go to the Timecode Format box on the left side of the dialog 
box and click on the circle next to the timecode that you are 
using.

4. Click on the OK button. (For more information, refer to Chapter 
6, “Timecode Options”.)

5. Set the faders and mutes as you want them for the initial set­
ting.*

6. Press RUN on the Global Master. (In most installations the 
Global Master is the control panel near the faders.) The RUN 
button will come on solid.

7. Put the transport into play. The SHIFT light on the Global 
Master will be on solid, indicating that good timecode is being 
received. When good timecode is being received, the RUN 
LED will flash, indicating that automation is on. Flying Faders is 
now ready to play and record moves and events.

8. Make the desired moves and events.

9. Stop the transport and rewind tape to the desired point. (Auto­
mation may be started or stopped at any point in timecode and 
the Pass will play from that point.)

10. Play the tape again to play back what was recorded.



WHAT HAS HAPPENED?
1. As soon as good timecode was being received, automation 

was turned on and any fader move or event that occurred 
was recorded by Flying Faders, creating a Pass. This initial 
Pass is called the Preset and is stored in RAM and assigned 
a number which is displayed in the Mix/Pass counter at the 
bottom of the main screen. This Mix/Pass system is ex­
plained in the next section of this chapter.

2. After tape was stopped and automation was turned on for 
the second time, the Pass that was created (the number in 
the Mix/Pass counter) was played back.
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AUTOMATION MEMORY
As soon as automation has been activated and good timecode is 
being received, the first fader touch or mute event that occurs will 
create a new Pass, which in turn becomes the current Pass. The 
next time automation is activated, that Pass is played back and any 
new moves or events are recorded, creating another new Pass. 
Each Pass created becomes part of the Pass chain and is an 
update of the one before it. In other words, as you play one Pass, 
you record an update of it. As you play that update back, you 
record a new update of it, and so on.

THERE ARE THREE TIMES WHEN A NEW PASS WILL 
NOT BE CREATED:

1. When RUN is turned off (disabling automation).

2. When no timecode is being received.

3. When no faders are touched and no new events occur.

Flying Faders stores information from each of these Passes in 
RAM. Any Pass may be stored to hard disk or floppy disk for more 
permanent safekeeping. (Refer to Chapter 5, "Mix Menu", for more 
information.)



MIX PRESET
When a new Pass is created from Mix 1/Pass 0, Flying Faders 
takes a snapshot of the intial fader, mute, relay, and channel 
buttong positions. This preset is used to establish the starting 
positions for all subsequent Passes in that chain. Fader presets 
can be changed using the “Trim Faders” feature discussed in 
Chapter 5. Mute, Channel Button and Relay presets can be 
changed from the Window.

The last Pass that was recorded was Mix 1/Pass 10. If you de­
cided to go back and play an earlier Pass from the chain (say Pass 
number 8) then Flying Faders would branch off at that Pass, giving 
the branch a new Mix number as well as a new Pass number (Mix 
2/Pass 1 in this case). If you play back and make any changes on 
Mix 2/Pass 1, the resultant Mix/Pass will be Mix 2/Pass 2, and so 
on.
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CREATING A NEW MIX
Normally the Pass that was just created becomes the next Pass to 
be played. But, if you didn’t like that Pass and don’t want to use it 
next, you can step back to any previous Pass.

When you move back to an earlier Pass, resume tape play, and 
record new moves, Flying Faders creates a new branch at that 
point and automatically assigns a new Mix number to it. Mix num­
bers are used as references to separate different branches of a 
Pass chain. For example, say that you have made a chain of 10 
Passes, each one an update of the one before it.



SELECTING A MIX/PASS

SELECTING THE CURRENT MIX/PASS

The Mix/Pass that is currently playing may be changed from the 
Global Master or a dialog box on the screen. To go to another Mix 
or Pass from the Global Master, use the Plus or Minus buttons. To 
change the Mix/Pass numbers from a dialog box, refer to Chapter 
5, “Select Mix/Pass”.

TO SELECT A MIX/PASS FROM THE GLOBAL 
MASTER:

1. End the current Pass by stopping tape (timecode) or by 
turning RUN off.

2. Use the Plus and Minus buttons on the Global Master to 
increment or decrement the Pass number. Use the 
SHIFT+Plus or Minus buttons to access another Mix branch. 
For example, if you are at Mix 2/Pass 2, in the previous 
example:

and wish to go back to Mix 1/Pass 8, then the keys to press 
would be:

PASS - (selects Mix 2/Pass 1)
PASS - (selects Mix 1/Pass 8)

SHIFT+PASS - (selects Mix 1/Pass 10) 
PASS - (selects Mix 1/Pass 9)
PASS - (selects Mix 1/Pass 8)
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SETTING THE SYSTEM TO MIX 1/PASS 0
If you wish to delete all Mix/Pass information currently in RAM, then 
refer to Chapter 5, “Clear Mix Memory”. If you wish to leave all the 
Mix/Pass information in RAM but want to start a completely new 
Mix with no presets, fader moves, or events, then use the Plus and 
Minus buttons to decrement to Mix 1/Pass 0, or refer to Chapter 5, 
“Select Mix/Pass”.



~w

\



Fader, Mute, & 
Channel Button 

Modes



2-2 USERS MANUAL - CHAPTER TWO



FADER, MUTE, & CHANNEL 
BUTTON MODES

FADER MODULE OVERVIEW

A. MUTE Button
This button is used to turn the mute on and off.

B. Mute RECORD LED
This LED is used as a recording indicator, RSI 
(Ready, Safe, and Isolate) indicator, and as a Touch 
Record and Lock Record indicator for the mute.

C. Mute RECORD Button
This button is used to toggle between mute Touch 
Record and Lock Record modes. When RSI on the 
Global Master is enabled, this button (used in 
conjunction with SELECT) is also used to toggle 
through RSI for the mute.

D. SOLO Button and LED
This button is used to place a channel in and out of 
Solo. The LED indicates that a channel is in Solo. 
(Solo must first be enabled at the Global Master.)

E. SELECT Button and LED
This button is used in conjunction with mute and 
fader RECORD for selection and interrogation of 
RSI, for the assignment and interrogation of Groups, 
Links and Solo banks, as a fader and mute touch 
indicator, and as a relay control button.

F. Fader RECORD LED
This LED is used as a recording indicator, RSI 
indicator, and a Touch Record and Lock Record 
indicator for the fader.

G. Fader RECORD Button
This button is used to toggle between Touch Record 
and Lock Record modes for the fader. When RSI on 
the Global Master is enabled, this button (used in 
conjunction with SELECT) is also used to toggle 
through fader RSI.

H. MATCH LEDs
The Match LEDs show the direction needed to move 
the fader in order to return it to the Play Pass 
position. They are also used for Group and Link 
interrogation.

I. AUTO/MATCH LED
This LED is used as a Match and Auto Match mode 
indicator.

J. MATCH Button
When pressed, a Match is performed. When used 
in conjunction with the fader RECORD button, the 
Auto Match mode will be activated.
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GLOBAL MASTER MODULE OVERVIEW
A. Master Touch Button and LED

Turns Master Touch on and off and indicates Master Touch 
status.

B. Mute RECORD LED
This LED is used as a global mute Touch Record and Lock 
Record indicator and a global RSI indicator.

C. Mute RECORD Button
This button is used to globally select mute Touch Record or 
Lock Record modes. When RSI is enabled, this button 
(used in conjunction with SELECT) is also used to globally 
toggle through mute RSI.

D. SOLO Button and LED
When used with the Global Master SHIFT, this button will 
enable and disable Solo. SOLO also selects between 
momentary and latching button operation, as well as serving 
as a global Solo cancel.

E. SELECT Button and LED
This button is used in conjunction with the mute or fader 
RECORD buttons for global RSI assignment and interroga­
tion and for selection and interrogation of Groups and Links.

F. Fader RECORD LED
This LED is used as a  global fader Touch Record and Lock 
Record indicator as well as a global fader RSI indicator.

G. Fader RECORD Button
This button is used to globally toggle between fader Touch 
Record or Lock Record modes. When RSI is enabled, this 
button (used in conjunction with SELECT) is also used to 
globally toggle between fader RSI.

H. MATCH LEDs
Inactive

I. AUTO/MATCH LED
This LED is used as a global Match and Auto Match indica­
tor.

J. MATCH Button
When pressed, a Match is performed on a global level.
When used in conjunction with the fader RECORD button, 
Auto Match will be activated for all faders.

K. GROUP Button
GROUP enables and disables the Group assign mode.

L. LINK Button
LINK enables and disables the Link assign mode.

M. RSI Button
RSI enables and disables the RSI select mode.

N. OTHER Button
OTHER currently enables and disables Trim or Graph, Set 
Solo Banks, Set Master Touch and Set Relay Control 
features.

O. RUN Button
RUN turns automation on and off.

P. Plus (+) and Minus (-) Buttons
The Plus (+) and Minus (-) buttons are used for incrementing 
and decrementing the Mix/Pass counter and for applying 
global Trim amounts.

Q. SHIFT Button
SHIFT is used in conjunction with the Plus (+) and Minus (-) 
buttons to change Mix numbers and for applying Global Trim 
amounts. It is also used as a modifier for the OTHER and 
SOLO buttons and for 'Locking' Master Touch on.
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SELECT
The functions of the Select buttons are controlled by the GROUP, LINK, RSI, 
and OTHER buttons on the Global Master. The use of the Select button for 
each of the assign/select modes on the individual faders will be discussed in 
their instructions.

FADER, MUTE, & CHANNEL BUTTON MODES 2-5

GROUP
This feature allows you to select a master fader and to assign slaves to that 
fader. If moves or mutes are made with the master, its slaves move or mute 
with ft, but, moving or muting a slave does nothing to the master or to the 
other slaves. The master fader position does not provide an absolute level 
set to the slave faders, but rather a simple offset in level. This allows for a 
slave to completely override a group move (such as a fade) if desired. Mutes 
follow two simple rules:

1. If a group master is muted, all associated slaves will also be 
muted.

2. If a group master is unmuted, all associated slaves will reflect 
their individual status.

Important..... Channel buttons are not included in groups.

Group moves and mutes are recorded on the master fader only. This means 
that if a slave fader is removed from a group, it will no longer follow the fader 
moves or mute events associated with that group. Because of this, all group 
structures in a mix are included in the information which is kept to disk and 
groups are re-formed when the mix is loaded from disk. (See "Coalesce 
Groups" in Chapter 9.)

GROUP HIERARCHY

With Flying Fader groups, a multi-level group structure or hierarchy 
may be formed. A simple example would be to create four groups 
consisting of rhythm, strings, brass, and vocals respectively, then 
create another group with it’s slaves consisting of the master fader 
of the other four groups. In essence, what is being set up is a 
master, sub-master, slave arrangement.



A more complicated example would be a film mixdown, where the 
dialog mixer, music mixer, and effects mixer each set up their 
portion of the console with a master, sub-master, slave arrange­
ment. The dialog mixer may then create group masters on his 
console for the music and effects mixes, and then place a grand 
master over everything. This set-up would have five levels of 
grouping.

GROUP CHARACTERISTICS
1. Any number of groups may be formed.
2. A master may have any number of slaves.
3. Any fader may be a group master, even if that fader is a 

slave in another group.
4. A slave can have only one direct group master. A slave may 

have any number of indirect group masters as a result of 
group hierarchy.

5. Group moves and mutes are recorded on the group master 
fader only. Slave moves and mutes (other than those 
caused by the group) are recorded on the respective slave 
fader.

6. The underlying status of a slave’s mute may be toggled 
while the slave is responding to a group mute.

7. A fader cannot be assigned to one group and its mute to 
another.

8. RSI settings of a group master do not affect it’s slaves, and 
vice-versa.

9. When a mix is kept to disk, group structures are included in 
the mix information.

10. Groups are always functional, regardless of fader modes, 
automation status, or presence of timecode (unless they are 
Coalesced or Suspended). Refer to Chapter 9, “Gangs", for 
more information.

11. Channel buttons are not included in groups.
12. Solo does not respect group assignments. (Soloing a mas­

ter will not solo its slaves.)

TO CREATE A GROUP:

1. Press GROUP on the Global Master to enable the group 
assign mode (GROUP LED on).
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2. Press the SELECT button on the fader that is to be the 
group master (the SELECT LED will flash).

3. Press the SELECT button on each fader that you wish to 
add (SELECT LED on) or remove (SELECT LED off) 
from this group. (If a fader’s MATCH LEDs are on dim, 
that fader is already a slave in another group and may 
not be a member of this group.)

4. Press the SELECT button on the group master (SE­
LECT LED off).

5. Repeat for other groups or press GROUP on the Global 
Master to disable the group assign mode (GROUP LED 
off).

Note................ If you wish to delete all groups currently in RAM,
refer to Chapter 9, “Gangs”.

GROUP INTERROGATION
The following section contains three methods of group interroga­
tion.

INTERROGATION BY USING SELECT:

FADER, MUTE, & CHANNEL BUTTON MODES 2-7

1. Turn off all assign mode buttons (GROUP, LINK, RSI,
OTHER) on the Global Master.

2. Press the SELECT button on the fader of interest.

3. The MATCH LEDs on all faders will stop showing any
match offsets and display one of the following:

a. Upper MATCH LED on solid: The fader is an indirect 
master of the selected fader.

b. Upper MATCH LED flashing: The fader is a direct 
master of the selected fader.

c. Lower MATCH LED flashing: The fader is a direct 
slave of the selected fader.

d. Lower MATCH LED on solid: The fader is an indirect 
slave of the selected fader.

e. Both MATCH LEDs on dim: The fader is a slave in 
another group and is not eligible to be a slave to the 
selected fader.

f. Both MATCH LEDs off: The fader is not a member of 
a group.



INTERROGATION BY TOUCH:
1. Turn off the assign mode buttons (GROUP, LINK, RSI, 

OTHER) on the Global Master.

2. Touch a group master fader (its SELECT LED will flash).

3. All direct and indirect slaves will turn on their SELECT 
LEDs.

INTERROGATION OF OVERALL GROUP 
STRUCTURES:

1. Press GROUP on the Global Master to enable the group 
assign mode (GROUP LED on).

2. Press the SELECT button on the Global Master.

3. The SELECT LEDs on all faders will display one of the 
following:

a SELECT LED off: Fader is not part of a group.

b SELECT LED flashing bright: Fader is a group mas­
ter only.

c. SELECT LED flashing dim: Fader is a group master
to one group and a slave in another group. -*•

d. SELECT LED on: Fader is a slave only.

Important..... For information on Group Coalesce, refer to Chap­
ter 9, "Coalesce Groups", in the Gangs menu.
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LINK
This feature allows you to interconnect faders so that moves or mute events 
that occur on any member of a link will be cloned to the other link members. 
Touching the fader or pressing the mute of a link member is exactly the same 
as touching all of the other members of the link at the same time.

Important......Channel buttons are not included in links.

Link moves and mute events are recorded to each link member. This means 
that if a fader is removed from a link, it will still play back all previously written 
fader moves and mutes associated with that link. As a result, links may be 
created and broken up at any time without the loss of moves or mutes. All 
current links in a mix are included in the information which is kept to disk, and 
the links will be re-formed when loading the mix from disk.

Important......When a link member is touched, the current fader
balance between link members will freeze (touching 
one is the same as touching all). Underlying moves 
will be recorded over, with the possibility that the 
amount of Match offset will vary from member to 
member. Performing a Match on one member will 
force all members to Match.

LINK CHARACTERISTICS

1. Any number of links may be formed.

2. A link may have any number of members.

3 A fader may be a member of only one link.

4. Link moves and events are recorded to each link member.

5. A fader cannot be assigned to one link and its mute to an­
other.

6. Changing modes on a link member changes modes for all.

7. When a mix is kept to disk, links are included in the mix 
information.

8. Links are always functional, regardless of fader modes, 
automation status, or presence of timecode.

9. Channel buttons are not included in links.

10. Solo does not respect link assignments. (Soloing a member 
will not solo the other members.)
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A fader may be assigned to both a link and a group. 
Link moves have priority over group moves, but 
group mutes will take precedence over link mutes.

TO CREATE A LINK:

1. Press LINK on the Global Master to enable the link 
assign mode (LINK LED on).

2. Press the SELECT button on a fader that is to be a link 
member (the SELECT LED will flash).

3. Press the SELECT button on each fader that you wish to 
add (SELECT LED on) or remove (SELECT LED off) 
from this link.

4. Press the SELECT button on the fader whose SELECT 
LED is flashing (SELECT LED off).

5. Repeat for other links or press LINK on the Global Mas­
ter to disable the link assign mode (LINK LED off).

Note............... If you wish to delete all links currently in RAM, refer
to Chapter 9, “Gangs”.

TO TEMPORARILY SEPARATE A FADER FROM A 
LINK:

1. Touch any fader in the link other than the one you want 
to separate.

2. Touch the fader that you want to separate while keeping 
your finger on the first fader.

3. Take your finger off the first fader (while keeping your 
finger on the other fader). The second fader will be 
removed from the link temporarily, but will rejoin the link 
as soon as you release it.

ADJUSTING LINK FADER BALANCE

To adjust the relative balance of a fader in a link, separate it
from the link and move it to the desired position.
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TO TEMPORARILY SEPARATE A MUTE FROM A LINK:

FADER, MUTE, & CHANNEL BUTTON MODES 2-11

1. Press any mute in the link other than the one you want to 
separate.

2. Press the mute that you want to separate while keeping 
your finger on the first mute.

3. Press the mute RECORD button of the first mute before 
releasing its mute button. This will prevent a toggle of 
the mute upon releasing the first mute button.

4. Toggle the separated mute as you like.

LINK INTERROGATION

Link interrogation may be performed by using the SELECT LED or
by touching the faders.

INTERROGATION BY USING SELECT:
1. Turn off all assign mode buttons (GROUP, LINK, RSI, 

OTHER) on the Global Master.

2. Press the SELECT button on the fader of interest (SE­
LECT LED will flash). The SELECT LEDs of all link 
members will flash.

INTERROGATION BY TOUCH:
1. Turn off all assign mode buttons (GROUP, LINK, RSI, 

OTHER) on the Global Master.

2. Touch the fader of the fader of interest (SELECT LED 
will flash). The SELECT LEDs of all link members will 
flash.



RSI (READY RECORD, SAFE, ISOLATE)

Faders and mutes can be set to Ready Record, Safe, or Isolate. If set to 
Ready, the playback and recording of moves and/or events is allowed. If set 
to Safe, the playback of previously made moves and/or events is allowed, but 
new moves or events can not be recorded. If set to Isolate, automation is 
disconnected, prohibiting the playback or recording of moves and/or events. 
RSI for faders and mutes may be set on individual faders or globally, by using 
the SELECT and RECORD buttons. The RECORD LEDs are used to indi­
cate the current RSI setting of a fader or mute.

RSI Setting 

READY 

SAFE 

ISOLATE

RECORD LED 

flashing 

on solid 

off

Note................These settings are shown only if RSI is on and the fader's
SELECT button is pressed.

LOCAL FADER RSI SELECTION:

1. Press the RSI button on the Global Master to enable RSI 
assign (LED on).

2. Press and hold the SELECT button on the desired fader.

3. Press the fader RECORD button to select the desired 
setting.

4. Press RSI on the Global Master to disable RSI assign.

LOCAL MUTE RSI SELECTION:

1. Press the RSI button on the Global Master to enable 
RSI.

2. Press and hold the SELECT button on the desired fader.

3. Press the mute RECORD button to select the desired 
setting.

4. Press RSI on the Global Master to disable RSI.
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GLOBAL FADER RSI SELECTION:
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1. Press the RSI button on the Global Master to enable 
RSI.

2. Press and hold the SELECT button on the Global Mas 
ter.

3. Press the fader RECORD button on the Global Master to 
select the desired setting.

4. Press RSI on the Global Master to disable RSI.

GLOBAL MUTE RSI SELECTION:
1. Press the RSI button on the Global Master to enable 

RSI.

2. Press and hold the SELECT button on the Global Mas 
ter.

3. Press the mute RECORD button on the Global Master to 
select the desired setting.

4. Press RSI on the Global Master to disable RSI.

Note................You may de-select any faders whose RSI
setting you don’t want changed by pressing 
their individual SELECT buttons (SELECT 
LED off) while pressing the SELECT button 
on the Global Master.

RSI INTERROGATION

If RSI is on, then the RSI setting of a fader or mute may be deter­
mined by pressing the SELECT button on the desired fader(s) and 
looking at the RECORD LEDs. RSI may be viewed globally or on 
individual faders.

TO VIEW RSI SETTINGS BY FADER:
1. Press RSI on the Global Master (LED on).

2. Press and hold the SELECT button on the desired fader 
to see the RSI status of that fader and mute.

TO VIEW RSI SETTINGS GLOBALLY:
1. Press RSI on the Global Master (LED on).

2. Press and hold the SELECT button on the Global Master 
to see the status of faders and mutes on all faders.



OTHER
The OTHER button on the Global Master allows you to access the Trim 
Faders dialog box, the Graph window, and the Set Solo Banks, Set Master 
Touch and Relay Control features. Graph is discussed in this section, but 
since Trim may be accessed via a menu as well as by OTHER, it is covered 
in Chapter 5, "Trim Faders".

GRAPH
This feature allows you to see moves made by a fader in any 
selected Mix/Pass. There are two ways fader moves may be 
displayed: The first shows one minute of moves (30 seconds on 
either side of the current timecode location). For example, if the 
timecode was stopped at 01:25:00, then moves from 01:24:30 to 
01:25:30 would be drawn. The second mode displays ALL moves 
for the entire Mix/Pass.

Graphs are displayed in 6 colors to help distinguish them. Time- 
codes are the same color as their graph and displayed in 8 digit 
format without colons. Additionally, timecodes are displayed 
without Local Zero offset applied and therefore the timecode dis­
played for a graph will be exactly the same whether or not Local 
Zero is on. Remember that windows of this type may be moved 
and/or resized. ^

TO GRAPH FADER MOVES:

1. Make sure that the OTHER button on the Global Master 
is off.
2. Press the Global Master SHIFT+OTHER button, or click 
directly on Other Key box on the main screen, so that
the box displays Graph (not Trim ).
3. Press the OTHER button on the Global Master and the 
Graph window will be opened.
4. Press the SELECT button on the fader(s) that you wish 

to graph. (This displays one minute of moves.) To dis­
play all moves over the entire Mix, hold SHIFT on the 
Global Master and press SELECT on the desired 
fader(s).

5. Press the Global Master SHIFT+OTHER to clear the 
Graph window.

6. Press the OTHER button to close the Graph window.
-6
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SET SOLO BANKS

The Set Solo Banks feature allows you to change which faders are 
controlled by the Global and Multi-Man Solo systems. You may 
wish to set a default Global Solo set and default Multi-Man Solo 
sets as well in the System Initialization File (see Technical manual). 
However, you may wish to change this during a session and this 
OTHER mode allows you to do that.
If you are in Solo Global mode, the Select LEDs on each channel 
tell if that particular channel is part of the Global Solo system. In 
other words, if you press a member or members of the Global set, 
they will be unmuted while all other members will be muted. In this 
mode you can use the Select buttons to select/deselect faders.

TO SELECT WHICH FADERS ARE PART OF THE GLO­
BAL SOLO SYSTEM:

Either:
1) Change other mode to Set Solo Banks by pressing 

Shift+Other on the Global Master Module.
2) Select Other Mode by pressing the Other key.
3) Switch to Global Solo mode, or Use ‘Select Faders for 

Global Solo’ option in Gangs Menu.
Then:

1) Use Select buttons to (de)select faders to be part of Global 
Solo.

2) Press Other Key when finished.

If you are in Solo Multi-Man mode, you can use the Select buttons 
to form groups of faders that will work together in a solo. Selection 
of sets is exactly the same as setting link structures. For example, 
pressing the Select button on fader 1, then 2, then 3, selects a 
Multi-Man solo bank that includes faders 1, 2, and 3. Pressing 
fader 1, or turning off the OTHER mode, closes the operation.
Now, if we press the solo button on fader 2, fader 2 will be 
unmuted and faders 1 and 3 become muted.
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TO SELECT WHICH FADERS ARE PART OF THE 
MULTI-MAN SOLO SYSTEM:

Either:
1) Change other mode to Set Solo by pressing Shift+Other on 

the console.
2) Select Other Mode by pressing the Other key.
3) Switch to Multi-Man Solo mode (see above), or Use ‘Select 

Faders for Multi-Man Solo’ option in Gangs Menu.
Then:

1) Use Select buttons to select/deselect faders to be part of 
Multi-Man Solo in the same way you would define links (see 
section on defining links earlier in this chapter). Just as with 
links you may set up as many groups of solo-faders as you 
wish.

2) Press Other Key when finished.

If you are in Solo Off mode, the OTHER mode Set Solo Banks has 
no function.

SET MASTER TOUCH

The Set Master Touch feature allows you to change which faders 
and mutes are part of the Master Touch system. You may wish to 
set default members of the Master Touch system in the System 
Initialization File (see Technical manual). However, you may wish 
to change this during a session and this OTHER mode allows you 
to do that. If you enter this Set Master Touch mode, the mute 
Record LEDs indicate which mutes are in the Master Touch system 
and the fader Record LEDs indicate which faders are in the Master 
Touch system. The Select LED will be lit on a channel if either the 
mute or fader is part of the Master Touch system. You can use the 
mute and fader Record buttons respectively to select/deselect 
mutes and faders from the Master Touch set. See “Set Master 
Touch” in Chapter 9 for more information about Master Touch.

RELAY CONTROL

Some systems may have external Relay Control panels while 
others will not. If you do not have external control panels or if you 
wish to control relays from the fader buttons, you should use the 
Relay Control OTHER mode. In this mode, faders which have 
been associated with Relays (either through the Relay Setup Win­
dow under the Lists Menu or through the System Initialization File) 
will be controlled/examined via the associated channels’ Select
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LED and button. The button and LED work exactly the same as 
the external Relay buttons. For more information on the Relay 
System, see “Relay System” in Chapter 8.

FADER, MUTE, AND CHANNEL 
BUTTON RECORD MODES

This section explains the Record modes for faders, mutes, and channel 
events.

Important Recording of fader moves, and mute and channel events only
occurs when:

1. Good timecode is being received (SHIFT LED on solid).

2. Run is selected (RUN LED is flashing).

3. Appropriate RECORD LED is flashing.

FADER RECORD MODES

4  When the RSI setting for a fader is set to Ready, various record
modes become available. These modes may be selected at any 
time, at each individual fader or globally at the Global Master 
Module.

TOUCH RECORD
In this mode the fader starts by playing back the moves of 
the Play Pass. When you touch the fader, all moves that 
you make will be recorded. Upon release, the fader will 
resume playing back the moves of the Play Pass, along with 
any offset in level incurred. The Match LEDs will indicate if 
an offset is present.

Note............... If timecode is interrupted (stop tape, etc.) or RUN is
turned off with an offset in effect, the offset will be 
carried out to the end of the mix. A Match must be 
performed if this is not desired. (Refer to “Match” in 
this section.)

4

FADER, MUTE, & CHANNEL BUTTON MODES 2-17



TO SET A FADER TO TOUCH RECORD:
1. The selected fader’s RSI must be set to Ready.

2. Press the fader RECORD button so that the fader Rec­
ord LED and AUTO MATCH LED are both off.

TO GLOBALLY SET FADERS TO TOUCH RECORD:
1. The selected faders’ RSI must be set to Ready.

2. Press the Global fader RECORD button so that the 
Global fader RECORD LED and AUTO MATCH LED are 
both off.

Note ............... A fader’s RECORD LED will flash slowly when
recording in Touch Record. When in Play, the LED 
will be off.

LOCK RECORD
In this mode, the fader starts by playing back the moves of 
the Play Pass. When you touch the fader, all moves that 
you make will be recorded. Upon release, the fader will 
continue in record as if being touched, staying in the position 
where you released it. (If the fader is in a group or a link, it 
will still follow all group or link moves while recording in Lock 
Record.) Recording ends at that point in the mix when one 
of the following occurs:

1. A Match is performed.
2. The fader is taken out of Ready.
3. Run is turned off.
4. Timecode is stopped (stop tape,etc.).

The MATCH LEDs will indicate if an offset is present.

Note ................If timecode is interrupted (stop tape, etc.) or RUN is
turned off with an offset in effect, the offset will be 
carried out to the end of the mix. A Match must be 
performed if this is not desired. (Refer to “Match” in 
this section.)

4
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TO SET A FADER TO AUTO MATCH:
1. The selected fader’s RSI must be set to Ready.

2. Simultaneously press the fader RECORD and MATCH 
buttons. (The AUTO/MATCH LED will come on solid.)

TO GLOBALLY SET FADERS TO AUTO MATCH:
1. The selected faders’ RSI must be set to Ready.

2. Simultaneously press the fader RECORD and MATCH
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TO SET A FADER TO LOCK RECORD:
1. The selected fader’s RSI must be set to Ready.

2. Press the fader RECORD button so that the fader REC­
ORD LED is on and the AUTO MATCH LED is off.

TO GLOBALLY SET FADERS TO LOCK RECORD:
1. The selected faders’ RSI must be set to Ready.

2. Press the Global fader RECORD button so that the 
Global fader RECORD LED is on and the AUTO MATCH 
LED is off.

Note................A fader’s RECORD LED will flash quickly when
recording in Lock Record and will be on solid in 
Play.

AUTO MATCH
In this mode, the fader starts by playing back the moves of 
the Play Pass. When you touch the fader, all moves that 
you make will be recorded. Upon release, the fader will 
automatically perform a Match, gliding back to the Auto 
Match position. When the Glide ends, play is resumed. The 
Auto Match Glide rate may be changed from the Glide 
Times dialog box. (Refer to Chapter 6, “Glide Times”.)

Notes..............If timecode is interrupted (stop tape, etc.) or RUN is
turned off with an offset in effect, the offset will be 
carried out to the end of the mix. A Match must be 
performed if this is not desired. (Refer to “Match” in 
this section.)

As the fader glides during an Auto Match, it will 
increasingly follow the dynamics of the Play Pass 
moves.



buttons on the Global Master. (The AUTO/MATCH LED 
will come on solid.)

Notes.............The fader RECORD LED will flash when recording
in Auto Match. (Recording occurs while the fader is 
being touched and during the Glide.) The AUTO/ 
MATCH LED will flash while the fader is Gliding. 
When playing, the RECORD LED will be off and the 
AUTO/MATCH LED will be on solid.

In the Auto Match mode, the MATCH LEDs point 
toward the Auto Match position while recording a 
move. When the fader is playing moves, the 
MATCH LEDs point toward the Play Pass position 
(if there is an offset). Pressing the MATCH button 
will perform a Match (not Auto Match) eliminating 
the offset from the Play Pass position.

MATCH
Whenever you want the fader to Glide from its current posi­
tion to the Play Pass position, press the MATCH button and 
the fader will move to the Play Pass position. Once there, 
recording ends and playback of old moves begins. The 
Match Glide rate may be changed from the Glide Times 
dialog box. (Refer to Chapter 6, “Glide Times”.)

Notes.............As the fader glides during a Match, it will increas­
ingly follow the dynamics of the Play Pass moves.

Match does not affect faders in Isolate.

TO PERFORM A LOCAL MATCH:
Press the MATCH button on the fader at the point in the 
mix that you wish the fader to Glide to the Play Pass 
position.

TO PERFORM A GLOBAL MATCH:
Press the MATCH button on the Global Master at the 
point in the mix that you wish all faders to Glide to their 
respective Play Pass positions.
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Note.
x j  q c p o r d  LED will flash when recording 

• r e t J « ^ e A U T O /M A T C H L ED w , 
flash while the fader is Gliding.

MUTE RECORD MODES
When RSI for a mute is set to Ready, two record modes become 
available. These modes may be selected at any time at each 
inriiwiriiini mute, or oloballv at the Global Master Module.

TOUCH RECORD
In this mode, the mute starts by playing back the mutes of 
the Play Pass. Upon pressing down on the mute button, 
record is activated. During the time that you hold the button 
down, all underlying Play Pass mutes will be ignored. Upon 
releasing the mute button, the mute will toggle and recording 
ends. The mute will resume playback of the Play Pass at 
the next event which will cause the mute to toggle to the 
opposite state.

Important..... If two sequential "on" mutes exist on the same
channel, the latter mute will remain in the Mute List 
as long as tape (timecode) does not play past that 
mute. For example, a mute “on" has been recorded 
at 01:05:45:03. On a subsequent pass, a mute "on" 
is recorded two minutes prior at 01:03:44:27 and 
then tape (timecode) is stopped before the mute at 
01:05:45:03. If you look at the Mute List, both 
mutes are included in the list and do, in fact, exist. 
On the other hand, if tape (timecode) is played past 
the mute at 01:05:45:03 and no other mutes exist 
between these two points, the mute at 01:05:45:03 
will be deemed redundant and removed, automati­
cally creating a new Mix/Pass.

TO SET A MUTE TO TOUCH RECORD:
1. The selected mute’s RSI must be set to Ready.

2. Press the mute RECORD button so that the mute REC­
ORD LED is off.
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TO GLOBALLY SET MUTES TO TOUCH RECORD-
1 • The selected mutes’ RSI must be set to Ready.—  ^  * icauy.

thanhe^mme R E t^ ^ D  LED?soff!n G'° bal Master s°

Note,
• A mute's RECORD LED will flash slowly when 

Ktordmg ,n Touch Record and will be off while

TO ERASE MUTE EVENTS:

1. The selected mute’s RSI must be set to Ready.

2. Select the Touch Record mode.

3. Press down on the mute button (to activate record) just 
ahead of the mute event to be erased.

4. Continue to hold the mute button down until you have 
passed the unwanted mute event(s).

5. Press the mute RECORD button before releasing the 
mute button. This will cause the mute not to toggle upon 
release of the mute button.

LOCK RECORD
In this mode the mute starts by playing the mutes of the Play 
Pass. Upon pressing down on the mute button, record is 
activated and locked on. Upon releasing the mute button, 
the mute toggles and recording continues. As long as rec­
ord is activated, all underlying Play Pass mute events will be 
ignored. Recording ends when one of the following occurs:

1. The mute is taken out of Ready.

2. Run is turned off.

3. Timecode is stopped (Stop tape, etc.).

Important..... If two sequential “on" mutes exist on the same
channel, the latter mute will remain in the Mute List 
as long as tape (timecode) does not play past that 
mute. For example, a mute ’‘on" has been recorded 
at 01:05:45:03. On a subsequent pass, a mute "on" 
is recorded two minutes prior at 01:03:44:27 and 
then tape (timecode) is stopped before the mute at 
01:05:45:03. If you look at the Mute List, both
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mutes are included in the list and do, in fact, exist. 
On the other hand, if tape (timecode) is played past 
the mute at 01:05:45:03 and no other mutes exist 
between these two points, the mute at 01:05:45:03 
will be deemed redundant and removed, automati­
cally creating a new Mix/Pass.

TO SET A MUTE IN LOCK RECORD:
1. The selected mute’s RSI must be set to Ready.

2. Press the mute RECORD button so that the mute REC­
ORD LED is on solid.

TO GLOBALLY SET MUTES IN LOCK RECORD:
1. The selected mutes’ RSI must be set to Ready.

2. Press the mute RECORD button on the Global Master so 
that the mute RECORD LED is on solid.

Note...............A mute’s RECORD LED will flash quickly when
recording in Lock Record and will be on solid while 
playing.

CHANNEL BUTTON RECORD MODES

This section explains Touch Record and Isolate for channel but­
tons.

TOUCH RECORD
If set to Touch Record, the channel buttons start by playing 
back the events of the Play Pass. Upon pressing down on a 
channel button, record is activated for that button. During 
the time that you hold the button down (activating record) all 
underlying Play Pass events for that button will be ignored. 
Upon release, it will toggle and recording ends. The channel 
button will resume playback of the Play Pass.

ISOLATE
Channel buttons are unaffected by fader and mute RSI 
settings, but they may be placed in Isolate by disabling the 
desired channel button in the Automate Channel Buttons 
dialog box. (Refer to Chapter 6, "Automate Channel But­
tons", in the Options menu.)
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SOLO
The Flying Faders solo system works independently of a console’s 
solo and is accessed by the solo buttons above the select buttons 
on each fader. The main features of the solo system are:

1) Multi-man solo operation allows the console to be divided to 
allow individual solo systems for several users at once.

2) Solo may be disabled on particular channels allowing effect 
returns and masters, for example, to be excluded from the 
solo system.

3) Soloing a channel does not disturb previously recorded 
mutes.

4) New mute events can be recorded on channels that are 
begin solo’ed.

5) Momentary or latching button operation.
6) Solo’ed group masters solo their slaves as well.

TO SELECT GLOBAL SOLO/MULTI-MAN SOLO/DISABLED 
SOLO:

Press the Global Master SHIFT+SOLO or click on the Solo Box on 
the main screen to disable solo and to switch between multi-man 
and global operation.

TO SOLO A CHANNEL:

1) Enable solo to either Global or Multi-Man operation.
2) Press SOLO on the channel or channels that you wish to 

solo.

The solo’ed faders will be unmuted regardless of their mute state 
and the other faders in the Solo section will be muted. With auto­
mation on and solo engaged, mutes will not play on faders within 
the solo group, although you can still record mutes normally.

MOMENTARY OR LATCHING OPERATION

The solo buttons may be set to momentary or latching operation. 
The SOLO button on the Global Master is used to toggle between 
these two modes. In latched mode, pressing the solo button will 
solo a fader until solo is pressed again. In momentary mode, the 
fader stays solo’ed only while the solo button is pressed. In addi­
tion to changing between momentary and latched mode, the mas­
ter Solo button will unsolo any latch-solo’ed faders.
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Additional Notes On Solo

4- Solo does not recognize Link structures, but it does recognize
groups. Pressing solo on a group master will act exactly as if the 
solo button was pressed on all the slaves as well.
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FLYING FADERS 
COMPUTER

TURNING ON FLYING 
FADERS

1. Turn on the AC MAINS breaker and the MOTOR POWER 
switch on the Flying Faders power supply unit.

2. Turn on the computer and the video display unit (VDU).

Note...................Remove any disks that might be present in the
floppy drive before applying power to the com­
puter.

If you have a mix data disk or another floppy disk in the drive, this
error message will appear:

Non-System disk or disk error.
Replace and strike any key when ready.

Remove the disk and hit any key on the computer keyboard to
continue the automatic load from the hard disk. When the system
is ready for mixing, the blue Flying Faders screen will appear.

Important.........If at any time the Flying Faders screen remains
red longer than one minute, turn the computer off 
and back on again. If this doesn't solve the prob­
lem, call Neve service.

FLYING FADERS COMPUTER 3-3



MICROSOFT WINDOWS
The Flying Fader’s human interface is made possible through the 
use of Microsoft Windows. Windows is an integral part of Flying 
Faders, providing a graphic display of the operating parameters of 
the system. Upon powering up Flying Faders, both Windows and 
the Flying Faders program are automatically loaded. If you are not 
familiar with Microsoft Windows, we recommend that you read this 
section before you start using Flying Faders.

Figure 3.1: Flying Fader's main screen with the ‘System' menu box pulled down

A WINDOW MAY INCLUDE:
1. Menu Bar • Contains the names of the menus in the system. This is the

horizontal list across the top of the Flying Faders screen. (Figure 3.1)
2. Menu - Contains a list of all the commands and dialog boxes contained in that 

particular menu. (Figure 3.1)
3. Control Box - Used to close, clear, or quit the active window. (Figure 3.1)
4. Scroll Bar - Used for viewing information that wont fit in the entire window.

(Figure 3.2)
5. Dialog Box - Displayed when more information is needed to carry out a 

command. (Figure 3.2)
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Figure 3.2: Automate Channel Butttons dialog box.

USING THE MOUSE/TRACKBALL
Your system comes with either a mouse or a trackball. This point­
ing device controls the pointer on the screen. If you position the 
pointer over the function to be executed and click the mouse/ 
trackball button, that function will be performed.

Note..................If you have a pointing device with more than one
button, use the leftmost button to control Flying 
Faders.

COMMON POINTING DEVICE TERMS:

Click - Press the button once.

Double Click - Quickly click the button twice.

Drag - Click the button and hold it down while moving the mouse/ 
trackball. When finished, release the button.

THE POINTER USED FOR FLYING FADERS HAS FOUR 
SHAPES:

Arrow - Used for the selection of functions.

I-Beam - A pointer that is used for entering text. For example, if 
you move the pointer around in the Load Mix dialog box, you will 
notice that when the mouse/trackball is in the areas where text is to 
be inserted, it changes from an arrow to an I-beam. The flashing 
vertical line in the box is the insertion point. This is where new text 
can be entered. The insertion point can be moved around with the 
pointing device or the space bar on your keyboard.
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Two-Headed Arrow - Used for changing the size of the Text 
Pages window, Diagnostics window, Help window, and the Graph 
window. If you move the pointer over the border of a window, it 
changes to a two-headed arrow. Drag the two-headed arrow to 
change the window size.

Hourglass - The pointer changes to an hourglass figure while you 
are waiting for a function to be executed.

USING THE KEYBOARD
On your keyboard the keycap names may be abbreviated or repre­
sented a little differently. For example, the ENTER key on the 
standard keyboard (Figure 3.4) is the same as the EXECUTE key 
on the Neve V Series keyboard (Figure 3.5). In this manual, the 
name of a key in a keystroke appears in capital letters, for ex­
ample, ALT, SHIFT, TAB, etc. A plus sign (+) between two key­
strokes means to hold the first key and press the second 
(ALT+CTRL). By using certain keystrokes, commands may be 
chosen to carry out functions on Flying Faders.

Here is a list of some frequently used keystrokes that are common 
to both keyboards:

ALT- Pressing ALT by itself will select the main screen 
menu title box.

ALT+Underlined letter - To open a menu or go to an area 
within a dialog box. For example, look at the System menu 
title in the main screen menu bar. Notice that the "S" in 
System is underlined. If you press ALT+S, the System 
dialog box will open.

ARROW DIRECTION KEYS - Used to move through menu 
titles, menus, or between related options in a dialog box.

ESC or BACK - Used to backspace in text areas. (The 
same as pressing BACKSPACE on the standard keyboard.)

Figure 3.4: Standard keyboard

CANCEL - Voids or nulls the current operation. (The same 
as pressing ESC on the standard keyboard.)
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EXECUTE or RETURN - Executes any highlighted 
command in the menu bar, a menu, or a dialog box. (The 
same as pressing ENTER on the standard keyboard.)

TAB - Move between options in a dialog box.

SHIFT+TAB - Move backwards among options in a dialog 
box.

SPACEBAR - Select or de-select an option in a dialog box.
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Figure 3.5: Neve V Series keyboard
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SELECTING
Throughout this manual you will be instructed to select commands 
or items from the screen. You may do so with the mouse/trackball, 
the keyboard, dedicated keys, or a combination of all. These 
methods of selecting are described in this section. Elsewhere, the 
manual will simply refer to “select” and leave the best method up to 
the user. Take time to experiment with these different methods to 
find a combination that best suits you.

SELECTING MENUS 
AND MENU ITEMS

When a menu name is chosen, that name is highlighted. When a 
menu is opened, the menu drops down from the menu bar to 
display its list of commands and dialog boxes. The following tech­
niques allow you to access a menu bar and its menus.

Note..................A dialog box has ellipses (...) following its title to
distinguish it from a command.

USING THE MOUSE/TRACKBALL:
1. Click the desired menu title. (Figure 3.6)

Figure 3.6: Using the mouse to
select menu items. 2. Click on the command or dialog box title that you wish to

select.

USING THE KEYBOARD:
1. Press ALT and then use the left or right arrow DIRECTION 

keys to select a menu title from the menu bar.

2. Press EXECUTE to open the menu.

3. Use the up and down arrow DIRECTION keys to select the 
command or dialog box from the menu list.

4. To execute the command or open the dialog box, press 
EXECUTE.

Or

1. Press ALT+underlined letter in the menu bar to select the 
desired menu.

2. Press the underlined letter in the menu list to choose the 
desired command or dialog box.
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THE PARTS OF A DIALOG BOX
Most dialog boxes are made up of several different areas. This is an 
overview of the parts that make up dialog boxes and their use.

Figure 3.7: The 'Load Mix" dialog box.

A DIALOG BOX MAY INCLUDE:
1. List Box - This box contains choices available to the user. To 

make multiple selections from a list box that allows multiple 
selections, press and hold SHIFT then click and/or drag on your 
choices. To make more than one selection with a keyboard, 
use the SHIFT + ARROW direction keys. (Figure 3.7)

2. Text Box - This is where information is inserted by the user.
The flashing vertical line is the insertion point. Anything that 
you type will appear to the left of the insertion point, moving any 
existing text to the right. (Figure 3.7)

3. Scroll Bars - Used in list boxes and text boxes as well as in 
windows to view information that wont fit in the entire dialog 
box. You may use the mouse/trackball to operate the scroll bar 
by dragging the small white box that is in the scroll bar and 
releasing it at the desired location. To scroll one line at a time, 
click the arrow boxes at the ends of the scroll bar. You may 
scroll one entire box length by clicking the scroll bar in the
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shaded area or by pressing PAGE UP or PAGE DOWN on the 
keyboard. (Figure 3.7)

4. Command Buttons - Used to perform various operations, such 
as approving or canceling settings in a dialog box. These are 
the buttons with curved sides. The button with the bold border 
is set as the default, meaning that if you press EXECUTE, that 
button will automatically be chosen, regardless of where you 
are in the dialog box. The three most common command 
buttons are:

OK - Selecting OK executes your choice and returns you to the main 
screen. (Figure 3.7)

CANCEL - Selecting CANCEL will return you to the main screen as if the 
dialog box was never opened, voiding any changes. (Figure 3.7)

EXIT - Selecting EXIT will return you to the main screen.

HELP - Selecting HELP opens a Help box dedicated to that particular 
dialog box. (Figure 3.7)

INACTIVE COMMANDS - If a command is shaded gray, it is 
inactive and cannot be used at that moment. (Figure 3.7)

5. Option Buttons - Circular buttons used to select an option in a 
dialog box. (Figure 3.7)

6. Check Boxes - Small squares used to select one or more 
options in a dialog box. (Figure 3.7)

SELECTING AN ITEM 
IN A DIALOG BOX

In order to select an item, you need to move to the location con­
taining that item. The following explains how this is done.

USING THE MOUSE/TRACKBALL:
1. Click directly on the area or setting that you want to select. 

(Figure 3.8)

Figure 3.8: Point the mouseArackball and click.

FLYING FADERS COMPUTER 3-11



USING THE KEYBOARD:
1. Press TAB to move to the desired area. (You may also 

press SHIFT+TAB to move in the opposite direction.) The 
area that you are currently in will be highlighted.

2. Use arrow DIRECTION keys to go to a specific item within 
that area.

3. Press SPACEBAR to choose the item.

Or

1. ALT+underlined letter

2. Use arrow DIRECTION keys to go to a specific item within 
that area.

3. Press SPACEBAR to choose the item.

101:45:30:151
Figure 3.9: Entering the entire 
Timecode

ENTERING TIMECODE NUMBERS:
1. Select the timecode field. (Figure 3.9)

2. Valid time code numbers may now be inserted. (Figure 3.9)

3. Select OK or go to the next option.

Hours, minutes, seconds, and frames may be edited individually.

1. Select the timecode field.

2. Double click the mouse on the hours, minutes, seconds, or 
frames and a highlighted block will appear. (Figure 3.10)

3. Insert your changes. (Figure 3.10)

4. Select OK or go to the next option.

Figure 3.10: Editing the hours, 
minutes, seconds, or frames 
separately.

1. Select the timecode field.

2. Press INSERT and a highlighted block will appear. Use the 
left or right arrow DIRECTION keys to move the block.

3. Insert your changes.

4. Select next option or OK.
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DIRECT-WINDOW ACCESS 
AND ACCELERATOR KEYS

There are alternate methods to open dialog boxes or execute 
commands without going through the menus. They are as follows:

DIRECT WINDOW ACCESS

Most primary functions can be accessed directly from the main 
screen via the mouse/trackball For example, clicking on the Labels 
area on the main screen is the same as selecting the Label List 
from the Lists menu.

ACCELERATOR KEYS

These are special keys used to execute a command without using 
the menu or the mouse/trackball. For example, click on the Mix 
menu title. Notice the function key assignments to the right of the 
menu listings. If you wanted to open the Keep Mix dialog box 
without using the pointing device, you would press the F7 key. Not 
all functions have accelerator keys, but the most commonly used 
do.

ACCELERATOR KEY ASSIGNMENTS

-Accelerator keys on the Neve V Series keyboard are labeled with 
their specific function.

-The majority of the accelerator keys on the standard keyboard are 
function keys F I-F I 2. There are a few, however, that use CTRL 
(refer to the following list).
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Neve
Keyboard

Standard
Keyboard Function Performed

S11......................... 1GTRL+F11 ...... Creates a new Snapshot
S12......................... <CTRL+F12...... Show/Hide the Stores box

LABEL.................... ( F I ) .................. Calls up the Label List
MUTE..................... (F2).................. Calls up the Mute List
CH BUTTON......... (F3).................. Opens the Channel Button 

Event List
EVENT................... (F4).................. Inactive
STORE................... (F5).................. Calls up the Stores List
MIX/PASS.............. (F6).................. Opens the Mix/Pass dialog 

box
KEEP...................... (F7).................. Opens the Keep Mix dialog 

box
LOAD..................... (F8).................. Opens the Load Mix dialog 

box
MERGE.................. (F9).................. Opens the Merge Channel 

Data dialog box
CODE..................... (F10)................ Opens the Timecode Options 

dialog box
UNDO.................... (F11 ) ................ Undo
HELP...................... (FI 2 ) ................ Help

SMART KEYS
Smart keys on the Neve V Series keyboard (S1-S10) are for exe­
cuting user programmable command sequences. (Refer to Chap­
ter 6, “Options Menu", for programming information and Smart key 
access on the standard keyboard.)
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CTRL+A....... ........ CTRL+A........... Repeats Last Command
CTRL+F....... ........ CTRL+F........... Toggle Safety Stop on/off
CTRL+K....... ........ CTRL+K........... Capture Mark Time (Label #0)
CTRL+L........ ........ CTRL+L........... Locate
CTRL+N....... ........ CTRL+N........... Safety Nets On/Off
CTRL+O....... ........ CTRL+O........... Toggle Other key between

Trim /G raph/Solo
CTRL+Q....... ........ CTRL+Q........... Exit Windows (Leaves the 

computer switched on)
CTRL+R....... ........ CTRL+R........... Toggle Run On/Off
CTRL+T....... ........ CTRL+T........... Run Recall Software
CTRL+Z....... ........ CTRL+Z........... Undo



DISKDRIVES

Figure 3.11 3.5 ' floppy disk

Your computer contains both a hard disk drive and a floppy disk 
drive. The Flying Faders program is installed on a portion of the 
hard disk, with the remaining space available for mix storage. The 
floppy disk (Figure 3.11) is generally used for archiving and trans­
ferring mix information. (Refer to Chapters 4 and 5, "System 
Menu" and “Mix Menu", for instructions on the use of the disk 
drives.)

Note.................. The floppy disk used for Flying Faders is a high
density disk (1.4 Megabytes). Be aware of the 
fact that 400K and 800K floppies wont work.

SOFTWARE VERSION NUMBER
As Neve and Martinsound Technologies continue to address the 
needs and wants of mixing engineers worldwide, we will be adding 
features and making changes to the Flying Faders software. If at 
any time you contact Neve with questions or comments regarding 
your Flying Faders system, you will need to inform them of the 
software version installed in your system. The version number is 
found under the About Flying Faders menu in the main screen 
control box. (Figure 3.12)

Figure 3 .2 ; Flying Fader's main screen with the 'System* menu box pulled down

FLYING FADERS COMPUTER

Figure 3.12: Flying Fader's Version Number
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SYSTEM MENU

The 'System' pull-down menu is found on the menu bar located at the top o f the main Flying Faders screen.
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CLIENT INFORMATION
This command allows you to inform Flying Faders of the current 
Client, Project, and Title being worked on. This information will 
appear in the Project/Title box of the main screen, as well as in the 
Keep, Load, and Delete dialog boxes. Client information may be 
changed from any of these dialog boxes and the changes will be 
automatically updated in the other locations.

TO INSERT CLIENT INFORMATION:

1. Select Client Information from the System menu or click the 
Project/Title box on the main screen.

2. Insert the Studio, Client, Project, and Title names in the 
appropriate boxes. (Note: Inserting a different studio name 
will not change the system default. It simply customizes the 
main screen for the current session.)

3. Select OK to close the dialog box.
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CALIBRATE FADERS
This command allows you to calibrate all of the faders, so that each 
fader moves accurately and consistently. The calibration automati­
cally tunes the faders and stores the setting to the hard disk. The 
next time that you turn on or reset the system, the faders will be 
calibrated using these values, making it unnecessary to repeat this 
routine each time the system is used.

TO CALIBRATE:
1. Select Calibrate Faders from the System menu.

2. A dialog box will appear on the screen indicating that calibra­
tion is taking place. Upon completion of calibration, any 
fader that cannot be calibrated to be accurate and consist­
ent will have its channel number displayed in the dialog box 
along with percentage numbers indicating that servicing of 
that fader may be necessary.

3. When calibration is finished, all faders and mutes will return 
to their previous positions and states. Select OK to close 
the dialog box.

-f Important................ If calibration seems necessary, it is best to do
so after the Flying Faders power supply unit 
has been turned on for at least 30 minutes.

RUN RECALL SOFTWARE
This command will allow you to access certain features on Neve 
VR Series consoles. For further information, refer to the Recall 
Manual.
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RESET SYSTEM
This command allows you to do a total system reset, as if powered 
down and powered back up. This is an excellent way to prepare 
the system for a new session without rebooting.

Warning.........Because of the nature of this command, caution
should be taken. All Mix/Pass information in RAM 
will be erased, so be sure to save important Mix/ 
Passes to hard disk or floppy disk before performing 
this command.

TO RESET SYSTEM:
1. Select Reset System from the System menu.

2. A dialog box will appear asking you to confirm the reset. 
Select OK to proceed or select CANCEL to return to the 
Flying Faders main screen.

3. After resetting the system, a dialog box will appear, inform­
ing you of the status of the transport controller. Select OK to 
close each dialog box.

SHOW DATE AND TIME
This command allows you to view the current date and time from 
the Flying Faders main screen.

TO SHOW DATE AND TIME:
1. Select Show Date and Time from the System menu.

2. Select OK to close the dialog box.

(Refer to the Flying Faders Technical Manual to change the date 
and time.)
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SHOW MEMORY STATISTICS
This command allows you to view the status of the system RAM. 
When selected, a dialog box appears informing the user of the 
memory available, memory used, and the total amount of RAM in 
your system.

TO SHOW MEMORY STATISTICS:
1. Select Show Memory Statistics from the System menu, or 

click on the Free RAM area in the lower left corner of the 
main screen.

2. Select OK to close the dialog box.

SHOW CONSOLE STATISTICS
This command allows you to view the status of faders and mutes. 
When selected, a dialog box appears, informing you of the current 
modes of faders and mutes.

TO SHOW CONSOLE STATISTICS:
1. Select Show Console Statistics from the System menu.

2. Select OK to close the dialog box.
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SHOW DIAGNOSTICS 
WINDOW

This command allows you to enter the "command line” of Flying 
Faders. Most users should never need to access this window, but, 
if you wish to view this window you are strongly urged to refer to 
the “Diagnostics Window" chapter in the Flying Faders Technical 
Manual.

TO SHOW DIAGNOSTICS WINDOW:
1. Select Show Diagnostics Window from the System menu.

2. Refer to the Flying Faders Technical Manual.

3. Select the control box, then select Close Diagnostics Win­
dow to return to the Flying Faders screen.
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MIX MENU
♦

The ‘M ix' pull-down menu is found on the menu bar located at the top o f the main Flying Faders screen.
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KEEP MIX
This command allows you to store a mix, along with mix-related 
information, from the system’s RAM to the hard disk and/or your 
floppy disk for permanent safekeeping. Remember that your mixes 
are held in RAM as you work. In the event of a power failure, 
mixes in RAM will be lost. Keeping to disk now and again is good 
insurance, especially in areas with power difficulties. Keeping is 
also done for archival purposes or for carrying out mixes to another 
Flying Faders facility. The Keep Mix command will not affect the 
Mix/Pass information in RAM. The data which will be kept in­
cludes:

1. All fader moves

2. All mute events

3. Groups and Links

4. Mix Notes

5. Locate Times (including Preroll)

6. Reel Start & End Times

7. Auto Record Times

8. Label List (title specific)

9. Channel Names List (title specific)

10. Glide Times

11. Smart Keys

12. TimecodeType

13. Local Zero

If your Flying Faders system is equipped with Events, the following 
data will also be included:

1. All channel button events

2. All A/B Cut Bus events

MIX/PASS

The mix that will be kept to disk is the Mix/Pass that is displayed in 
the Mix/Pass counter on the main screen.
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Important..... The Keep Mix command will only recognize the mix
resulting from the Pass chain, not the Pass chain 
itself. Mix/Pass numbers are simply locate points in 
RAM for different mixes!

FILE ORGANIZATION

Flying Faders keeps mixes in a traditionally organized filing system. 
Sets of files will be presented in alphabetical order. The principle 
files are your Clients (e.g. record companies). Under a specific 
client name are subfiles, which are the different Projects (e.g. 
artists’ albums) that the client is working on. Under each project 
are sub-subfiles, which are the different Titles (e.g. songs) for that 
project. Under these titles will be found the related mixes that you 
have kept.

‘WORKNAME’ DEFAULTS

If you open the Keep Mix dialog box without giving Flying Faders 
any Client Information, the Client box will read ‘workclient’. This is 
the system default along with ‘workproject’, ‘worktitle’, and 
‘workmix\ These defaults have been inserted so that you may 
keep with minimal keystrokes and/or minimal interfacing with the 
screen. Keeping to these ‘work’ files is not necessarily in your best
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interest, as it can be difficult to distinguish one ‘workmix’ from 
another. But you will find it useful for that “one-off session, that 
quick scratch mix, or to help a novice get started on Flying Faders. 
And remember, if a ‘workmix’ develops into a master or final mix, 
then you may keep under an actual Client, Project, Title, and Mix 
name at that time.

MIX VERSION NUMBERS

To avoid redundant mix files, the system automatically assigns a 
mix version number to all subsequent keeps of a previously used 
mix name (e.g. FINAL, FINAL.01, FINAL.02).

TITLE VERSUS MIX

When you keep, most of the information is directly related to a 
specific mix name. But the information pertaining to the Label List 
and Smart Keys is shared by all mixes under a specific title name. 
As a result, if you keep a mix after making changes to the Label 
List or Smart Keys, the changes will be found in all previously kept 
and future kept mixes with the same title name.

MIX NOTES

The Mix Notes box is used for adding comments to the mix that 
you are about to keep. Comments may include: Describing subtle 
differences between similar mixes or version numbers, document­
ing Merge parameters, noting timecode offsets for machine control­
lers, etc. Mix Notes from the Mix/Pass dialog box are automatically 
copied to this box.

LOCATE TIMES

The times displayed in the Locate Times area of the main screen 
will be included with the mix that you are about to keep. These 
times will be shown in the Locate Times box of the Keep Mix dialog 
box. The Select From List command button allows you to change 
the Locate Times.

DISK

The Disk box allows you to choose the storage medium (hard disk 
or floppy disk) to which a mix will be kept.
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TO KEEP A MIX:
1. Insert the Mix/Pass that you wish to keep in the Mix/Pass 

counter on the main screen. (Refer to “Select Mix/Pass" in 
this chapter.)

2. Press KEEP on the Neve V Series keyboard, or select Keep 
Mix from the Mix menu.

3. Insert the appropriate names in the Client, Project, Title, and 
Mix boxes.

4. Insert any mix notes into the Mix Notes box.

5. Insert any changes into the Locate Times box.

6. Select the disk to which you will keep. Check the Disk 
Name to verify that you are keeping to the correct disk. Also 
check the “Free Disk Space” indicator to insure that there is 
room for your mix.

7. Select Keep to store the mix to disk.

8. A dialog box will appear indicating that your mix has been 
successfully kept. Select OK to close the dialog box.

SAVE IN OLD MIX FORMAT

Flying Faders Version 3.0 saves files in a compressed format. This 
means that the mix will take up less space on your disk and may 
also be saved faster. However, versions prior to Version 2.0 and 
Flying Faders Junior W\W not be able to read these compressed 
files. If you plan to Load the mix into one of these systems, check 
the 'Save in Old Mix Format' box when Keeping the mix. This will 
save the mix in a format which can be read.
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LOAD MIX
This command allows you to choose a mix from a disk and dupli­
cate it in the computer’s RAM. Loading a mix will not disturb any 
other mixes in RAM, the system simply finds the first available Mix/ 
Pass location and places the mix there. This provides a way of 
loading multiple mixes in RAM for mix editing. Mix-related informa­
tion is recalled when loading a mix and is used to reset several 
aspects of the system. The following will be reset:

1. Groups and Links

2. Mix Notes

3. Locate Times (including Preroll)

4. Reel Start and End Times

5. Auto Record Times

6. Label List

7. Channel Names List

8. Glide Times

9. Smart Keys

10. TimecodeType

11. Local Zero

MIX 1/PASS 0 VS. CLEAR RAM

In order to load a mix, the Mix/Pass counter must be set to Mix 1/ 
PassO. There are two ways to do this: If the mixes currently in 
RAM are not to be erased, then click Mix 1/Pass 0. Or, if there is 
nothing in RAM that is needed, click Clear RAM. This will also 
return you  to  M ix 1 /P ass  0.

Warning.........Because of the nature of the Clear RAM command,
caution should be taken. All Mix/Pass information in 
RAM will be erased, so be sure to save important 
Mix/Passes to hard disk or floppy disk before per­
forming this command.

SHOW NOTES

This command allows you to preview your mix notes for the se­
lected mix, so that you may confirm your choice before loading.
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DISK

The Disk box allows you to choose the disk (hard disk or floppy 
disk) from which a mix will be loaded.

LOAD OPTIONS: OFFSET TIMECODE

This function allows you to resolve any possible differences be­
tween the timecode originally used when the mix was kept and the 
timecode currently being used. This can be useful in video produc­
tion, where timecode gets shifted quite often.

LOAD OPTIONS: COALESCE GROUPS

This function allows you to Coalesce a Group or Groups upon 
loading a mix to RAM. Refer to Chapter 9, "Gangs", for more 
information.

co
l

LOAD OPTIONS: REASSIGN CHANNELS

Reassign Channels is a new feature of Flying Faders in version 
3.0. The Reassign Channels feature allows you to more easily 
load mixes that were saved on one Flying Faders console onto 
another, differently configured Flying Faders console.
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To use Reassign Channels you must be loading a version 3.0 mix 
or you will get a message saying “Channel information cannot be 
found for this mix.” Furthermore your console must have a console 
configuration file (see Technical Manual).

REASSIGNING CHANNELS

From the Load Window, press the Reassign Channels button. The 
Reassign Channels Window will appear. On the left is a box called 
‘Faders On This Console’. The list in this window corresponds to 
the physical faders you have on your console. On the right is a box 
called ‘Unassigned Channels’. The list in this window corresponds 
to the information stored in the mix on disk (presumably from an­
other Flying Faders system).

The idea is to assign channels from the unassigned box to the 
Console box. Flying Faders knows about your consoles configura­
tion and the stored mix tells the configuration of the console it 
came from. So if you select one or more unassigned channels 
from the ‘unassigned’ list and press the Automatic button, Flying 
Faders will match those faders which have equivalent types of 
faders on your console (e.g. Group Master, Stereo Master, channel 
faders, etc.) Some faders may not have equivalents or you may 
wish to override the automatic assignments Flying Faders gives.
To do this you select an equal number of ‘console’ and ‘unas­
signed’ faders and press the Manual button which will then force 
the one-to-one assignment. If you have assigned faders on your 
console with data and change your mind, select the faders and 
press the Free button and they will return to the ‘Unassigned Chan­
nels’ list. If you wish to swap the data assigned to one of your 
faders with data from another, select them both and press the 
‘Swap Two Channels’ button.

When you’ve defined the reconfiguration you want, press the OK 
button. The Reassign Channels check box will automatically be 
checked and the load will use the reconfiguration you selected.
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WHAT HAPPENS WHEN I REASSIGN CHANNELS?
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Say you’re working in Studio A with 72 faders and you move to Studio 
B with 60 faders. In both rooms there are 2 stereo and 2 group mas­
ters. The only difference is that Studio A has 12 more regular faders. 
When I load a mix from A onto B, the first 56 of Studio A’s faders will 
be assigned to console B’s first 56 faders. Then the last 4 of Studio 
A’s faders (the masters) will be assigned in the master fader positions 
on console B, 57 thru 60.

The remaining 12 faders worth of data will not be lost. It will be 
loaded into “Phantom Fader” positions. The data will be kept with 
subsequent mixes and, if one of the Phantom Faders was a member 
of a group or link, it will still behave as such. If it was in a link, new 
link moves will be written to it, and if it was a master in a group, it will 
still move its slaves. These behaviors may not be desirable some­
times and you may wish to remove the link or group. Since Phantom 
Faders do not have physical faders associated with them, they also 
do not have select buttons. So you cannot use Group and Link mode 
to remove the Links or Groups. Two new features under the Gangs 
Menu have been added to help. ‘Clear Selected Groups’ and ‘Clear 
Selected Links’ allow you to remove an individual link or group as­
signment. (Note that with Clear Selected Link, the entire link is dis­
solved if any of the members are selected).

Let’s say you save the mix after working on it for a while on console B 
and then return to Studio A. Flying Faders remembers where those 
phantom faders were and would reassign those 12 Phantom Faders 
to positions 57 thru 68 (and hence they are no longer Phantoms), 
move the masters back to 69 thru 72, and leave faders 1 thru 56 
alone.

Let’s now imagine that started on console B and saved a normal 60 
channel mix and then took it to studio A. When you press Reassign 
Channels, the first 56 faders will be assigned to 1 thru 56. The last 
four faders from the mix (saved in B) are masters and will be as­
signed to positions 69 thru 72 in studio A. Faders 57 thru 68 will have 
no faders assigned to them. When you load the mix, default preset 
data will be assigned to those channels (and a message will tell you 
what happened).

MODIFYING THE ASSIGNED CHANNELS

The “Faders on this Console” are the channels that will be loaded into 
the the current physical faders. The Unassigned faders will be loaded 
as Phantom Channels, and will appear on all channel lists as ‘P’ 
channels.



MANUAL ASSIGN

To manually assign channels to the Console:

1. Select the channels from the Unassigned Channels box that 
you wish to assign to this Console.

2. Select the locations that you wish to assign these channels 
to in the “Faders on this Console” list. You must select an 
equal amount of channels.

3. Press MANUAL Assign.

The selected Unassigned Channels will be assigned to the loca­
tions on the Console list. If a location on the Console was already 
assigned a channel, the old channel is Freed and placed in the 
Unassigned Channels list.

AUTOMATIC ASSIGN

Automatic assignment provides any easy way to reassign channels 
by using the Channel Description Tags. Automatic assignment 
takes selected channels from the Unassigned Channels list and 
assigns them to the Console location with a matching Channel tag.

To automatically assign channels to the Console:

1. Select the channels from the Unassigned Channels list that 
you wish to be automatically assigned.

2. Press AUTOMATIC Assign.

NOTE: When assigning a channel, if there is no free Console 
location that has a matching tag, then the channel will 
not be assigned.

FREE

To Free channels assigned to the Console:

1. Select the channels from the Console list that you wish to be 
Freed.

2. Press FREE to remove these channels from the Console list.
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SWAP TWO CHANNELS

You are also allowed to swap two channels in the Console list. 

To Swap two Channels:

1. Select two Channels from the Console list that you wish to 
be swapped.

2. Press SWAP TWO CHANNELS.

LOAD OPTIONS: APPEND STORES LIST

When loading the Stores for a mix, you have the option of either 
overwriting the old Stores, or appending them. Checking the Ap­
pend Stores List box will preserve the Stores in memory, and ap­
pend the loaded Stores to the end of the current Stores list. When 
Stores are appended, they are renumbered.

LOAD OPTIONS: APPEND PRESENTATION LIST

You also have the same option with the presentation list. Checking 
the Append Presentation List box will preserve the Presentation 
List in memory, and append the loaded Presentation List.

Note that if the loaded Stores are appended (and renumbered), the 
Presentation List is modified so that they still refer to the loaded 
Stores.
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TO LOAD A MIX:
1. Press LOAD on the Neve V Series keyboard, or select Load 

Mix from the Mix menu.

2. Select the Clear RAM or Mix 1/Pass 0 command button.

3. Select the disk that contains the mix that you want to load 
from the list of mixes.

4. Select the Client command button. The list of clients will 
now appear in the list box.

5. Select the desired client from the list.

6. Repeat steps 4 and 5 to obtain the desired project, title, and 
mix names. Hint: If you double click on your choice from 
the list, it will be placed in the text box and the next list will 
show up, eliminating the need to use the Project, Title, and 
Mix command buttons.

7. Go to the Load Options box if you need to offset the time- 
code, swap channels, or Coalesce Groups upon loading.

8. Select Show Notes if you wish to confirm your choice.

9. Select the Load command button to load your mix and to 
close the dialog box.

DELETE MIX
This command allows you to remove a mix from a disk. Delete is 
used for reclaiming valuable disk space, e.g. removing old mixes 
from the hard disk, eliminating all the backup mixes before a final 
mix, etc. You may also remove Clients, Projects, and Titles from a 
disk.

Important..... Because of the system file arrangement, (refer to
File Organization under Keep Mix), if you delete a 
client, then all associated projects, titles, and mixes 
will be deleted. If you delete a project, then all 
associated titles and mixes will be deleted. Like­
wise, if you delete a title, then all of its associated 
mixes will be deleted.
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SHOW NOTES

This command allows you to preview your mix notes for the se­
lected mix, so that you may confirm your choice before deleting.

DISK

The Disk box allows you to choose the storage medium (hard disk 
or floppy disk) from which a mix will be deleted.

TO DELETE A MIX:
1. Select Delete Mix from the Mix menu.

2. Select the disk that contains the mix that you wish to delete.

3. Select the Client command button. The list of clients will 
appear in the list box.

4. Select the desired client from the list.

5. Repeat steps 3 and 4 to obtain the desired project, title, and 
mix names. Hint: If you double click on your choice from 
the list, it will be placed in the text box and the next list will 
show up, eliminating the need to use the Project, Title, and 
Mix command buttons.

6. Select Show Notes if you need to confirm your choice.
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7. Select the Delete command button.

8. A dialog box will appear asking you to confirm your choice. 
Selecting YES will permanently delete your choice. (Not 
even EXIT will be able to correct deleted items after this 
point, so be extremely careful when using Delete.)
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SHOW MIX STATISTICS
This command allows you to view certain details about the current 
Mix/Pass. It informs you of the points in timecode between which 
all fader moves have occured. It indicates the faders on which 
there are fader moves, mute events, and channel button events. It 
also notifies you of the amount of memory used by the Mix/Pass 
chain that you are currently in.

TO SHOW MIX STATISTICS:
1. Select Show Mix Statistics from the Mix menu. A dialog box 

displaying facts about the current Mix/Pass will appear.

2. Select OK to close the dialog box.



SHOW MIX/PASS TREE

CLEAR MIX MEMORY
This command allows you to clear all current Mix/Pass information 
from RAM, resetting the Mix/Pass counter to Mix 1/Pass 0.

Warning........Because of the nature of this command, extreme
caution should be taken. All Mix/Pass information in 
RAM will be erased, so be sure to save important 
Mix/Passes to hard disk or floppy disk before per­
forming this command.

TO CLEAR MIX MEMORY:
1. Select Clear Mix Memory from the Mix menu.
2. A dialog box will appear to verify your request to delete all 

Mix/Pass information currently in RAM.
3. Select OK or CANCEL.
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The Mix/Pass Tree maps out all related Mix/Pass numbers and 
allows you to see their relationship with one another. Whenever a 
new mix is created, Flying Faders starts a new branch so you can 
easily view the heirarchy of the Mix/Pass numbers.

TO SHOW MIX/PASS TREE:
1. Select Show Mix/Pass Tree from the Mix menu.

2. A help window will appear showing the current Mix/Pass 
tree.



TRIM FADERS
This command allows you to adjust the level of all or some of the 
faders for the current Mix/Pass. You may trim through a dialog 
box, the Global Master, or by moving the faders manually. Trim 
may be adjusted when automation is on, so you can see and hear 
the effects in real time. The Trim may be set to occur between two 
times, or the entire Mix/Pass may be Trimmed.

Note............... The Mix/Pass that you are adjusting is left undis­
turbed in RAM. If automation is on and the trim 
amount has been set, Flying Faders creates a new 
Mix/Pass as soon as OK is selected or tape (time- 
code) is stopped. If automation is still on and you 
decide that you don’t want to create a new Mix/ 
Pass, Trim can be cancelled by turning off the 
OTHER button on the Global Master or selecting 
CANCEL in the dialog box. At that point the faders 
will return to their original positions.

NUDGE TRIM

The Nudge Trim box has buttons that will let you trim in fixed steps 
of +1 dB, -1 dB, +0.1 dB, and -0.1 dB each time these are selected.

NUMERIC TRIM

The Numeric Trim box is similar to Nudge Trim, except that instead 
of fixed values, any number can be entered by typing it from the 
keyboard. Once a number is entered, the Trim+ and the Trim- 
buttons will apply that amount each time you select them.
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TRIM BETWEEN TIMES
The area at the bottom of the screen allows you to select the points 
between which the Trim will occur. The Trim may be designated to 
affect the entire Mix/Pass or only a selected section. If the Trim is 
assigned to take place between two timecode points, crossfade 
times may be set for the crossfade in and crossfade out. The 
timecode points and the crossfade times may be set by selecting 
the Set Trim Times command button.

SUSPEND GROUPS
The Suspend Groups box in the lower right comer of the Trim 
dialog box allows you to Trim a Group master without affecting its 
slaves. Refer to Chapter 9, “Gangs", for more information on 
Suspend Groups. Groups are automatically re-enabled when you 
leave Trim mode.

TAKE NEW PRESET
This command replaces the existing preset with the current fader 
positions, creating a new Mix/Pass.

TO TAKE A NEW PRESET:
1. Turn automation on (play tape, Run on).
2. Make the desired moves or mutes.
3. Stop tape.
4. Select Trim Faders from the Mix menu.
5. Select the Take New Preset command button.
6. A notice box will appear informing you of the new Mix/Pass 

that was created.
Note................A new preset may be taken only once for each time

the Trim Faders dialog box is opened.
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TO TRIM USING THE TRIM FADERS DIALOG BOX:
1. Call up the desired Mix/Pass.

2. Select Trim Faders from the Mix menu. The Trim box on 
the main screen will turn green and the OTHER button will 
flash on the Global Master.

3. Select the faders that you wish to trim from the Channels list 
box.

4. Select or enter the points that you wish to Trim between 
(preset to end or between times). Typing P + E will select 
Preset & End. Alternatively timecode values may be en­
tered or selected from the Label list.

5. Play tape. As you select buttons from the Numeric Trim or 
Nudge Trim boxes, the specified amount will be applied to 
the current Mix/Pass, creating a new Mix/Pass when OK is 
selected or tape (timecode) is stopped.

TO TRIM FADERS FROM THE GLOBAL MASTER:
1. Call up the desired Mix/Pass.

2. Make sure that the OTHER button on the Global Master is 
off.

3. Press the Global Master SHIFT+ OTHER, or click on the 
Other Key box on the main screen, so that Trim (not Graph) 
is displayed in the Other Key box.

4. Press the OTHER button on the Global Master. The OTHER 
button will light, the Other Key box will turn green, and the 
Trim Faders dialog box will open.

5. Select the faders that you wish to adjust from the Channels 
list box.

6. Select or enter the points that you wish to Trim between 
(preset to end or between times).

When Trim is enabled, the + and - buttons on the Global Master 
become preset amounts of trim.

PLUS (+) equals +.1dB
MINUS (-) equals -.IdB
SHIFT+PLUS (+) equals +1dB
SHIFT+MINUS (-) equals -IdB

Note................Where SHIFT is listed above, we are referring to the
SHIFT key on the Global Master.
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TO TRIM FADERS MANUALLY:
1. Call up the desired Mix/Pass.
2. Make sure that "Trim” is displayed in the Other Key box on 

the main screen, then press the OTHER button on the 
Global Master to open the Trim Faders dialog box.

3. Activate automation and manually move the fader(s) that 
you want to trim. When you release the fader(s) it will play 
its moves with the new preset applied. If further adjustment 
is needed, move the fader(s) again.

4. When you are satisfied with your adjustments, stop tape 
(timecode) or select OK and a new Mix/Pass will be created.

5. Turning off the Other button will also execute Trim.

MERGE CHANNEL DATA
This command allows you to take channel information (fader 
moves, and/or mute events, and/or channel button events) from a 
selected Mix/Pass and insert it into another Mix/Pass. You may 
specify the exact length of the information to be merged. The 
Merge command will not alter the Mix/Pass that you merge from or 
to, but will create a new Mix/Pass, which will be displayed in the 
Mix/Pass area. Merge is very fast, as it is done entirely in RAM, 
not on disk.
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TAKE FROM HERE AND INSERT IN HERE

The Mix/Pass that you want to copy information from, also known as 
the source mix, is entered in the Take From Here box. The Mix/Pass 
that you want to introduce the information into, also known as the 
destination mix, is entered in the Insert In Here box.

You may also choose to merge from a Store that you have created. 
To merge information from a Store, select the Store button and enter 
the number of the Store in the edit box. You can merge using the 
information from the current console settings by entering Store 0.

INCLUDE

The Include box allows you to select which elements are to be merged 
from a channel’s mix information. You may select fader (the fader 
movements) and/or mute (the mute events) and/or channel buttons 
(the channel button events).

SPLICE MODE

The Splice Mode box allows you to select whether the transitions 
between the source mix and the destination mix, at the merge start 
and end times, are to be Absolute or Relative. (The choice will affect 
the faders only. In both modes, the status of the mute and channel 
buttons on the selected channel(s) will be forced to match the source 
mix at the merge start time. At the merge end time, the status of the 
mute and channel buttons on the selected channel(s) will be forced to 
match the destination mix.)

ABSOLUTE

If Absolute is chosen, the selected fader(s) will crossfade from 
the destination mix position to the source mix position at the 
merge start time. This is done over the frames you allocate in 
the xFade Time box. At the merge end time, the selected 
fader(s) will move back to the destination mix position, once 
again occurring over the time shown in the xFade Time box.

RELATIVE

If Relative is chosen, the selected fader(s) will follow the source 
fader mix moves, referenced to the destination mix position at 
the merge start time. In other words, the selected fader(s) will 
follow the source mix moves with a relative offset. At the merge 
end time, the selected fader(s) will resume following the desti­
nation mix moves.
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SET TIMES

The Set Times box allows you to select the start and end points in 
timecode for the mix information to be merged. These points are 
referred to as Merge From and Merge End. Timecode may be 
entered manually or from the Label list by choosing Select From 
List.

CHANNELS

The Channels box allows you to select the channel(s) whose mix 
information will be merged.

Note ..............The data for channels that were not selected will not
be altered in the destination Pass.

TO MERGE CHANNEL DATA:
1. Press MERGE on the Neve V Series keyboard, or select 

Merge Channel Data from the Mix menu.

2. Enter the desired Mix/Pass in the Take From Here box or 
select a Store from which to Merge. Store 0 is the current 
console setting. You may press the Current Pass com­
mand button to merge from the current Mix/Pass.

3. Enter the desired Mix/Pass in the Insert In Here box or 
select Current Pass to insert the current Mix/Pass.

4. Select the channel mix information to be merged from the 
Include box.

5. Select Absolute or Relative from the Splice Mode box. 
Include the xFade Time if Absolute is chosen.

6. Insert Merge From and Merge To times in the Set Times 
box.

7. Select the desired channels from the Channels list. The 
Select All command is a quick way to choose all channels.

8. Select Merge to perform the Merge.

9. A dialog box will appear informing you of the new Mix/Pass 
that was created. This Mix/Pass is automatically selected 
as the Play Pass.

10. Select OK to close the dialog box.
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COPY CHANNEL DATA
This command allows you to duplicate channel information (fader 
moves, and/or mute events, and/or channel button events) from a 
designated channel to itself or to other channels. You may copy 
channel information from one Mix/Pass to another and from one 
point in timecode to another. You may also specify the exact 
length of the information to be copied. The Copy command will not 
alter the Mix/Pass that you copy from or to, but will create a new 
mix, which will be displayed in the Mix/Pass area of the main 
screen. Copy is very fast, as it is done entirely in RAM, not on disk.

SOURCE AND DESTINATION

The Mix/Pass that you want to copy information from, also known 
as the source mix, is entered in the Source box. The Mix/Pass that 
you want to copy information to, also known as the destination mix, 
is entered in the Destination box. Entering the same Mix/Pass in 
both boxes allows you to duplicate a channel’s mix information to 
the same or another channel(s) within that mix. It also allows you 
to copy a channel’s mix information with a timecode offset. Enter­
ing a different Mix/Pass in each of the two boxes allows you to 
copy channel mix information between what could be two unrelated 
mixes.
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INCLUDE
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The Include box allows you to select which elements are to be copied 
from a channel’s mix information. You may select fader (the fader 
movements) and/or mute (the mute events) and/or channel buttons 
(the channel button events).

SPLICE MODE

The Splice Mode box allows you to select whether the transitions 
between the source mix and the destination mix, at the copy start and 
end times, are to be Absolute or Relative. (The choice will affect the 
faders only. In both modes, the status of the mute and channel but­
tons on the destination channel(s) will be forced to match the source 
mix at the copy start time. At the copy end time, the status of the mute 
and channel buttons on the destination channel(s) will be forced to 
match the destination mix.)

ABSOLUTE
If Absolute is chosen, the destination fader(s) will crossfade 
from its own mix position to the mix position of the source fader 
at the copy start time. This is done over the frames you allo­
cate in the xFade Time box. At the copy end time, the destina­
tion fader(s) will move back to the destination mix position, once 
again occurring over the time shown in the xFade Time box.

RELATIVE
If Relative is chosen, the destination fader(s) will follow the 
source fader mix moves, referenced to its own mix position at 
the copy start time. In other words, the destination fader(s) will 
follow the source fader mix moves with a relative offset. At the 
copy end time, the destination fader(s) will follow the destination 
mix moves.

SET TIMES

The Set Times box allows you to select the start and end points in 
timecode for the mix information to be copied. These points are re­
ferred to as Source Start and Source End. Timecode may be entered 
manually or from the Label list by choosing Select From List. The Set 
Times box also allows you to select the start point in timecode to which 
the mix information will be copied. This point is referred to as the 
Destination Start. Once again, timecode may be entered manually or 
from the Label list by choosing Select From List.



SET CHANNELS

The Set Channels box serves two purposes. It allows you to select the 
channel from which mix information will be copied. This is known as 
the Source Channel. Only one Source Channel may be chosen for the 
copy. The Set Channels box also allows you to select the channel(s) 
to which the Source Channel’s mix information will be copied. This is 
known as the Destination Channel(s). You may copy to any number of 
channels.

TO COPY CHANNEL DATA:

1. Select Copy Channel Data from the Mix menu.

2. Enter the source Mix/Pass in the Source box or select the 
Current Pass command button to insert the current Mix/Pass.

3. Enter the destination Mix/Pass in the Destination box or select 
Current Pass to insert the current Mix/Pass.

4. Select the channel mix information to be copied from the In 
elude box.

5. Select Absolute or Relative from the Splice Mode box. Include 
the xFade Time if Absolute is chosen.

6. Insert Source Start, Source End, and Destination Start times in 
the Set Times box.

7. Select Set Source in the Set Channels box. Select the desired 
channel from the Source Channel list.

8. Select Set Destination in the Set Channels box. Select the 
desired channel(s) from the Destination Channels list. The 
Select All command is a quick way to choose all channels.

9. Select Copy to perform the copy.

10. A dialog box will appear informing you of the new Mix/Pass that 
was created. This Mix/Pass is automatically selected as the
Play Pass.

11. Select OK to close the dialog box.
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ERASE CHANNEL DATA
This command allows you to erase channel information (fader 
moves, and/or mute events, and/or channel button events) from a 
selected channel or channels. You may erase channel information 
from any point in timecode and you may also specify the exact 
length of the information to be erased. The Erase command will 
not alter the designated Mix/Pass, but will create a new mix, which 
will be displayed in the Mix/Pass area of the main screen. Erase is 
very fast, as it is done entirely in RAM, not on disk.

ERASE FROM HERE

The Erase From Here box allows you to choose the Mix/Pass from 
which you will erase mix information.

INCLUDE

The Include box allows you to select which elements are to be 
erased from a channel’s mix information. You may select faders 
(the fader movements) and/or mutes (the mute events) and/or 
channel buttons (the channel button events).
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SPLICE MODE

The Splice Mode box allows you to select whether the transition be­
tween the mix information prior to the erased area and the mix infor­
mation following the erased area is to be Absolute or Relative. (The 
choice will affect the faders only. In both modes, the mute and chan­
nel buttons will maintain the same status as at the Erase Start time. At 
the Erase End time, the status of the mute and channel buttons will be 
forced to match the remaining mix information.)

ABSOLUTE: XFADE AT START

If Absolute: xFade at Start is chosen, the fader(s) will 
crossfade from its Erase Start mix position to the Erase End 
mix position at the beginning of Erase. This is done over the 
frames you allocate in the xFade Time box.

ABSOLUTE: XFADE AT END

If Absolute: xFade at End is chosen, the fader(s) will crossfade 
from its Erase Start mix position to the Erase End mix position 
at the end of Erase. This is done over the frames you allocate 
in the xFade Time box.

RELATIVE

If Relative is chosen, then at the Erase End time the fader(s) 
will follow the subsequent mix moves, referenced to its mix 
position at the Erase Start time. In other words, the fader(s) 
will follow the mix moves with a relative offset.

SET TIMES

The Set Times box allows you to select the start and end points in 
timecode for the mix information to be erased. These points are 
referred to as Erase From and Erase To. Timecode may be entered 
manually or from the Label list by choosing Select From List.

CHANNELS

The Channels box allows you to select the channel(s) from which mix 
information will be erased.
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TO ERASE CHANNEL DATA:
1. Select Erase Channel Data from the Mix menu.

2. Enter the desired Mix/Pass in the Erase From Here box or 
select the Current Pass command button to insert the cur­
rent Mix/Pass.

3. Select the channel mix information to be erased from the 
Include box.

4. Select Absolute or Relative from the Splice Mode box. 
Include the xFade Time if Absolute is chosen.

5. Insert Erase From and Erase To times in the Set Times 
box.

6. Select the desired channels from the Channels list. The 
Select All command is a quick way to choose all channels.

7. Select Erase to perform the erasure.

8. A dialog box will appear informing you of the new Mix/Pass 
that was created. This Mix/Pass is automatically selected as 
the Play Pass.

9. Select OK to close the dialog box.
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MIX CONFORMING
The Mix Conforming dialog box offers several different operations 
useful when making mixes conform to film edits. These are:

Move To move parts of the mix around
Insert Stock To insert space into a mix 
Delete To cut out a part of a mix

Select the operation you wish to perform at the top of the dialog 
box.

CHANNELS

The Channels box allows you to select the Channel(s) on which the 
selected operation will be performed.

SETTING THE CROSSFADE TIME

The crossfade time is the time used when splicing together the mix 
after the selected operation has been completed. If the Insert 
Stock operation is chosen, this field is ignored.
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MOVE
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The Move command lets you move part of the current mix, creating 
a new, 'conformed' mix/pass as a result. All Channel information 
(fader moves, events, mutes, etc.) for the selected channels is 
moved. In 'post' work, Move is useful for cases where, for 
example, Scene 2 has been moved to be after Scene 3. Just as 
you conform the picture and sound for this new edit, Flying Faders 
will conform the automation to match.

The Move operation is not to be confused with the Copy operation. 
A Move first cuts the section out of the mix and then inserts it at the 
destination time. To visualize this process better, imagine your mix 
is a book with the pages numbered 1,2, 3, 4, 5, 6, 7... up to 15. If 
we were to move pages 3 through 7 to page 10, we would find that 
the pages would now be numbered 1,2, 8, 9, 10, 11, 12, 13, 14, 3, 
4, 5, 6, 7, 15. The 10th page would now be numbered 3.

To Move Part of the Current Mix

Select Move from the Operation box. Enter the beginning and end 
times of the segment to be moved 'Move This' box. Note that you 
only need to specify two of the times in this box (e.g. if you you 
enter the start time and the length, the end time will be 
automatically computed).

Enter the Destination time in the 'To Here' box.

Enter the crossfade time that will be used at each of the splice 
points.

Select the channels whose information is to be moved.

Press the Move button to perform the operation.

Inserting Blank Space into a Mix

The Insert command inserts blank space into the current mix, 
creating a new, conformed mix/pass as a result. This is necessary 
if say, a whole new scene is added to the film. During this space 
(■time') all faders, events and mutes will have the same initial 
settings as at the start of the inserted time.

To visualize this better, imagine that your mix is a book with the 
pages numbered 1, 2, 3, 4, 5, 6, 7, 8 ... If a space is inserted from 
page 3 to page 7, we would find the pages were now numbered 1, 
2, 3, 3, 3, 3, 3, 4, 5, 6, 7, 8 ... Note that no part of the original mix is



destroyed. It is just rearranged around an additional inserted 
section.

To Insert Blank Space into the Current Mix

Select Insert from the Operation box.

Enter the start time for the insert and its duration or end time in the 
'Insert Stock' box. Note that you only need to enter two of the 
times in this box, the third being automatically computed by Flying 
Faders.

Select the channels whose information is to be moved for the 
insert.

Press the Insert button to perform the operation.

Deleting Part of a Current Mix

The Delete command deletes channel information from the current 
mix, creating a new conformed mix/pass as a result.

All information including fader moves, events and mutes is deleted.

The Deleteoperation is not to be confuse with the Erase operation. 
The Delete operation physically cuts information out of your mix.

To visualize this process better, imagine your mix is a book, with 
the pages numbered 1, 2, 3, 4, 5, 6, 7, 8, 9,10... If you Delete 
pages 3 through 7, the pages will now be numbered 1, 2, 8, 9,10... 
where the third page is now numbered 8.

To Delete Part of the Current Mix

Select Delete from the Operation box.

Enter the beginning and end (or duration) times in the 'Delete' box. 
Only two times need to be entered, the third will be automatically 
computed.

Enter the crossfade times to be used at the splice points.

Select the channels whose information is to be deleted.

Press the Delete button to perform the operation.
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SELECT MIX/PASS
This command allows you to select a desired Mix/Pass through the 
Select Mix/Pass dialog box.

NEW MIX

This command allows you to start a new Mix/Pass branch. New 
Mix forces a new Mix/Pass number, which is useful when you want 
to create a reference point for the following Mix/Pass.

MIX NOTES

The Mix Notes box is used for adding comments to the current Mix/ 
Pass. Comments entered here will also appear in the Keep Mix 
dialog box.

HIDE NOTES/SHOW NOTES

This command allows you to open and close the Mix Notes win­
dow.

TO SELECT A MIX/PASS:
1. Press MIX/PASS on the Neve V Series Keyboard, or select 

Select Mix/Pass from the Mix menu, or click on the Mix/ 
Pass area of the main screen.

2. Insert the Mix number and the Pass number in the text 
boxes, or use the plus and minus buttons to increment or 
decrement the Mix and Pass numbers.

3. Select OK to close the dialog box.
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TO SELECT A MIX/PASS FROM THE GLOBAL 
MASTER:

1. The Mix/Pass numbers as they appear on the main screen 
may be changed by pressing the Pius (+) or Minus (-) but­
tons on the Global Master. To access another Mix/Pass 
branch, use SHIFT+Plus or Minus buttons on the Global 
Master.

RUN ON/RUN OFF
This command allows you to enable or disable automation. Auto­
mation is activated when Run is on and good timecode is being 
received.

TO TURN RUN ON:
1. Press RUN on the Global Master, or press CONTROL+R on 

the Neve V Series keyboard, or select Run On from the Mix 
menu, or click the O ff area on the main screen.

TO TURN RUN OFF:
1. Press RUN on the Global Master, or press CONTROL+R on 

the Neve V Series keyboard, or select Run Off from the Mix 
menu, or click the Run area on the main screen.
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Options Menu
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OPTIONS MENU

The 'Options ’  pull-down menu is found on the menu bar located at the top o f the main Flying Faders screen.
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SMART KEYS
This command allows you to program the Smart Keys on the key­
board. Smart Keys are an odd feature with many complicated 
behaviors. In order to use them effectively, you will need to under­
stand the issues involving Smart Keys, and how Flying Faders 
resolves these issues.

The goal of Smart Keys is to program a commonly used operation 
so that it is accessible by pressing one of the 10 keys labeled S1- 
S10 on the Neve keyboard and CTRL+(F1-F12) on the standard 
keyboard. For example, you might want key SI to set the Match 
Glide time to 30 frames and S2 to set the Match Glide time to 5 
frames. By pressing SI and S2 you could easily alternate between 
30 and 5 frames. To record the event, you tell Smart Keys to start 
recording, change the Match Glide Time, and then tell Smart Keys 
to stop recording. Unfortunately, it is not so simple. The computer 
must decide which events should be recorded and which should 
not. Using our example, we can see that many more events oc­
curred in addition to changing the Match Glide rate. After we 
started recording, we took several seconds to click on the Glide 
Times box. When the Glide Times dialog box opened, we took 
several seconds to select the rate. The whole time we were mov­
ing the mouse around and clicking on things. These things are 
also classified as events. When we click on OK we set the Match 
Glide time. In addition, whenever we set the Match Glide rate the 
Auto Glide rate is also set, yet another event.
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It may seem clear which events should be recorded in this ex­
ample, but every example is different. For example, we wouldn’t 
want to record the time it took to select the Glide times. But what if 
we wanted a Smart Key to reverse the transport for several sec­
onds? Then we would want to record the time lapse that occurred 
between pressing REWIND and STOP.

If we wanted to record a LOCATE/PLAY to a point on tape, we 
would start recording our Smart Key and press LOCATE followed 
by PLAY. Say that the locate time is 01:00:00. If we change the 
locate time later to 02:00:00, it is unclear whether we want our 
Smart Key to record a LOCATE to whatever the locate time is 
when we are recording the Smart Key, or to LOCATE to the current 
locate time. In other words, should it always LOCATE to 01:00:00, 
or should it always locate to the current locate time?

These issues are very complex and there is no simple solution that 
gives pleasing results all the time. Clearly, when using Smart Keys 
the events that are recorded will not always be the events you 
wanted to be recorded. We believe, however, that to best use 
Smart Keys you must understand the issues and our solutions. 
Without this understanding, Smart Keys can be very confusing.

In order to understand our solution, a brief explanation of our 
system must be given. Inside the Hewlett Packard Vectra is an­
other computer called a Viper 68000. It is responsible for control of 
the automated console hardware and most aspects of automation 
(recording moves and events, editing operations, transport control, 
changing passes, saving/loading, etc...) The Vectra converts 
mouse moves and clicks into requests for the Viper. For example, 
if you click on the Run/Off box, the Vectra asks the Viper to turn 
automation mode to Run or Off. It is this request that would be 
recorded as a Smart Key. It is not simple to understand which 
operations will be done by the Vectra alone and which operations 
require the Vectra to make a request of the Viper. Therefore, some 
trial and error will be necessary to gain an intuition for this concept. 
Note that anything you do directly on the console, apart from the 
Vectra’s keyboard, will NOT be recorded, because only requests 
that originate on the Vectra are recorded.

Here are some samples to start you off. If you click on ROLLBACK 
with the mouse, Smart Keys will record a ROLLBACK using the 
current Rollback time. If you change the Rollback time at a later 
time, it will not affect the behavior of the Smart Key. In other 
words, if the Rollback time was 10 seconds when you recorded the



Smart Key, the Smart Key will always rollback 10 seconds, even if 
you change the Rollback time to 20 seconds.

With automation in RUN, start recording Smart Key S I. Turn 
automation off (click on RUN/Off box), decrement the pass by 
clicking on the pass key in the Select Mix/Pass dialog box. Next, 
turn automation mode back to RUN (click on RUN/Off again). 
Finally, turn the Smart Key recording mode off. Repeat this proce­
dure on Smart Key S2, except click on the V  pass key. Now, while 
tape is rolling you can use keys SI and S2 to switch, on the fly, 
from the current Play/Pass to another Play/Pass without stopping 
tape (allowing you to easily A/B passes).

There is another type of problem that occurs. Every once in a 
while the Vectra tells the Viper the current time of day to keep the 
two computers synchronized (this is only used to view the current 
time and date and has no impact on automation). The problem 
with this is that the Vectra requests the Viper to update its clock 
whenever it feels like it. If this request occurs while recording a 
Smart Key, the time would be recorded too. This is a perfect 
example of how the limited event recording scheme may some­
times record extra unwanted events.

The solution is to carefully examine a Smart Key’s contents after 
you stop recording and to make sure that it makes sense and 
would do what you want your Smart Key to do. Note that a Smart 
Key’s contents are English requests. Everything that you type in 
the Diagnostics Window is also a request. You can use the Diag­
nostics Window to cause events that you want recorded to be 
recorded in a controlled fashion. For example, when you clicked 
on the key in the ‘Select Mix/Pass’ dialog box, the Smart Key 
recorded ‘pass -’. From the Diagnostics Window you could directly 
type ‘pass -’ and the pass counter would decrement just as if you 
clicked on t h e k e y  in the dialog box. If you were recording a 
Smart Key, it would also be recorded in the Smart Key.

Have fun and experiment. Smart Keys can be very useful, but due 
to the fact that the computer has no real intelligence, it can never 
really know what you want to do. You will need to watch them 
carefully and learn how the computer thinks, if you want to get the 
most out of this feature.

6-6 USERS MANUAL - CHAPTER SIX



RECORD KEY
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When selected, this command button starts recording the chosen 
Smart Key. Note that whatever was previously recorded into the 
Smart Key will be overwritten.

STOP RECORDING
When selected, this command button stops recording the Smart 
Key.

CLEAR KEY
When selected, this command button clears a Smart Key, erasing 
any information that was recorded onto that key.

EDIT MODES
The Edit Mode box allows you to choose how the Smart Key will be 
recorded. The Overwrite mode will delete any command lines 
previously recorded and replace them with newly recorded com­
mands. The Append mode will attach newly recorded commands 
to existing command lines. The Insert mode will add a newly 
recorded command(s) anywhere within previously recorded com­
mand lines. The Delete command button allows you to eliminate a 
selected command within a command line.

TO RECORD SMART KEYS:

1. Select Smart Keys from the Options menu.

2. Insert the desired Smart Key number in the Smart Key box.

3. Select the desired Edit mode from the Edit Mode box.

4. Select the Record Key command button.

5. Perform the events that you wish to program.

6. Select the Stop Recording command button.

7. Verify the commands that were recorded.

8. Select Exit to close the dialog box.

Note...............The recorded command lines for a Smart Key may
be reviewed by selecting the Smart Key number in 
the Smart Keys List.



GLIDE TIMES
This command allows you to adjust the Glide rates for Match and 
the Auto Match mode. The Glide times may be changed anytime, 
even while automation is running. Because a Glide is written into 
the fader data, a change in the Glide Time settings will not affect 
previously written Glides.

TO SET GLIDE TIMES:
1. Select Glide Times from the Options menu or click on the 

Glide Times area of the main screen.

2. Adjust the times as desired. A Glide Time may be changed 
by using a scroll bar or by entering the time in a text box.

3. Select OK to close the dialog box.
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TEXT PAGES
This command opens the Text Pages window. Text Pages is a 
simple word processor, available for making general notes, etc. 
This window is also used for editing the following files:

1. Transport Controller Constants
2. System Initialization File
3. System Diagnostics Report File

4. Channel Description File

Note................ For information about editing these files, refer to the
Flying Faders Technical Manual.

TO CREATE A FILE:
1. Select Text Pages from the Options Menu.
2. Type the desired text in the text area.
3. Select Save As from the File Menu.
4. Enter the name (8 characters maximum, ending with a 

period) that you wish to save the file under. If you wish 
to overwrite an existing file, select that file from the list.

5. Select the disk that you wish to save to (Hard Disk or 
Floppy Disk).

6. Select Save to store the file to disk.
7. Select Close from the File menu to exit Text Pages.

TO OPEN A FILE:
1. Select Text Pages from the Options Menu.
2. Select Open from the File menu.
3. Select the disk that the file is on (Hard Disk or Floppy 

Disk).
4. Enter the name of the file that you wish to open or select 

the file name from the list.
5. Select OK to open the file.
6. Select Close from the File menu to exit Text Pages.

TO DELETE A FILE:
1. Select Text Pages from the Options Menu.
2. Select Delete from the File menu.
3. Select the disk that the file is on (Hard Disk or Floppy 

Disk).
4. Enter the name of the file that you wish to delete or 

select the file name from the list.
5. Select Delete. A dialog box will appear asking you to 

confirm your choice. Select OK to perform the delete.
6. Select Close from the File menu to exit Text Pages.
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ADDITIONAL FILE FEATURES

NEW

New allows you to clear the window to create a new file. If the file 
that you are currently working on isn’t saved when New is chosen, 
a dialog box will appear asking you if you wish to save the current 
text to its proper file.

SAVE

Save is useful for updating files. If a file is opened and edits are 
made, choosing Save will update that file.

CANCEL CHANGES

If a file is opened and edits are made, Cancel Changes will restore 
the file to the way it was after the last save.

EDIT MENU

The Edit menu is available for file editing. The Cut, Copy, Paste, 
and Clear commands allow you to delete, duplicate, and reorgan­
ize text. The Select All command highlights all the text in the file, 
so that it can be copied or cleared. The Undo command allows 
you to reverse the latest command, including Undo itself.
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SAFETY NETS / SAFETY STOP

Safety Nets

This command allows you to set the times to be secured by Safety 
Nets. Safety Nets are used to set up a window between two points 
in timecode. Inside this window you may make new moves and/or 
events as desired, But outside of this window, the faders, mutes, 
and channel buttons are placed in the Safe mode, unaffected by 
any moves or events that may occur (accidental or otherwise).
This is desirable when you just want to make sure that data is 
protected outside of the area that you are working on.

TO SET SAFETY NET TIMES:
1. Select Set Safety Net Times from the Options Menu.

2. Go to the Safe Before box and enter the desired timecode in 
the timecode field, or select the timecode from the Label list, 
if available.

3. Go to the Safe After box and enter the desired timecode in 
the timecode field, or select from the Label list.

4. To activate Safety Nets upon closing of the dialog box, 
select Activate Safety Nets.

5. Select OK to return to the main screen.
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TO USE SAFETY NETS:
1. Set the Safety Net times.

2. Turn Safety Nets on by clicking on the box labeled Safety 
Nets in the transport area of the main screen (the box will 
turn yellow). Safett Nets may also be toggled on and off 
from the keyboard by pressing CTRL+N

3. Place the tape into play (the box will turn green).

4. When the Safe Before time is reached, Safety Nets will be 
turned off (the box will turn red) and any moves or events 
made will be recorded. When the Safe After time is reached, 
the faders will Match to their original Play Pass position (the 
box will turn green again). A new Mix/Pass will be created, 
and no additional moves or events will be recorded.

Note............... If tape (timecode) is stopped before the Safe After
time occurs, the faders, mutes, and channel buttons 
will still Match to the Play Pass Position at the Safe 
After time.

Safety Stop

This feature is similar to Safety Nets. When automation is turned 
off, a Match is performed on all faders, preserving the positions of 
the faders after that point.

To Use Safety Stop

Turn Safety Stop on by checking the ‘Activate Safety Stop' box. 
Safety Stop may also be toggled on and off from the keyboard by 
pressing CTRL+F.

If you want the system to verify the Match when automation is 
stopped, check the Verify box.

When automation is stopped, the faders will Match to their original 
play/pass positions (if Verify was selected, a question box will be 
brought up to confirm this). A new mix/pass will be created.
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TIMECODE OPTIONS
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This command allows you to choose timecode type, timecode 
display options, and local zero times.

TIMECODE TYPE

The Timecode Type box contains choices of 24, 25, and 30 (drop 
or nondrop) frames per second. Note: Flying Faders does not 
automatically determine the incoming code type. The default is set 
via the System Initialization File for the type of code you most often 
use, so check its setting before you start mixing (refer to the Tech­
nical Manual). If you forget, and the incoming code differs from 
what is set, a dialog box will appear informing you of this.

THE TIMECODE INDICATOR

The SHIFT button light on the Global Master serves as the time- 
code indicator, if the light is on solid, this indicates that valid time- 
code is being received. If the light is flashing, the system is receiv­
ing flakey timecode, and if the light is completely off, no code is 
being received. If the system is indicating that flakey or no time- 
code is being received, check to make sure that timecode is 
patched into Flying Faders and confirm that the timecode type is 
correct.

TO SET THE TIMECODE TYPE:
1. Press CODE on the Neve V Series keyboard, or select 

Timecode Options from the Options menu, or click on the 
timecode field in the lower right comer of the main screen.

2. Select desired timecode from the Timecode Type box.

3. Select OK to close the dialog box.



DISPLAY OPTIONS

The Display Options box allows you to mask the hours and/or 
frames on all timecode displays.

Note............... Full entry of timecode is required even if the hours
and/or frames are suppressed.

TO SET THE DISPLAY OPTIONS:
1. Press CODE on the Neve V Series keyboard, or select 

Timecode Options from the Options menu, or click on the 
timecode field in the lower right comer of the main screen.

2. Select the desired display alternatives from the Display 
Options box.

3. Select OK to close the dialog box.

LOCALZERO

This feature is used to display the running time of a mix, versus the 
timecode in use. Local Zero allows you to set a user-friendly 
reference to any point in timecode. When Local Zero is activated, 
running code will be offset so that the chosen point is displayed as 
00:00:00:00 in all timecode fields. Timecode may be entered 
manually or from the Label list by choosing Select From List.
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TO SET LOCALZERO:

OPTIONS MENU 6-15

1. Press CODE on the Neve V Series keyboard, or select 
Timecode Options from the Options menu, or click on the 
timecode field in the lower right corner of the main screen.

2. Insert the desired timecode.
3. Select Local Zero ON.
4. Select OK to close the dialog box.

Or

1. Click on Capture in the Local Zero area of the main screen 
at the desired point in timecode. This may be done on the 
fly or with timecode stopped.

2. Click on the Local Zero area to turn Local Zero on or off.

Note...............Local Zero is saved and automatically reloaded
with the Mix.

TIMECODE VS. FOOT-FRAMES

(Foot-Frames may not be available on all systems.)

Selecting these buttons changes the way timecode is diplayed on 
the screen. If Timecode is selected, the times will be displayed in 
hours:minutes:seconds format. If Foot-Frame is selected, times 
will be displayed in foot-frames.

SETTING FOOT-FRAMES OPTIONS

The Foot-Frames options let you select the conversion rate and 
offset for all displayed foot-frames times.

FILM FORMAT

The film format buttons should be set to the type of film you are 
using, so that the computer can properly convert SMPTE time to 
Foot-Frames. If a custom format is desired, enter the number of 
frames per foot and frames per second before the appropriate 
boxes after the “Other” option. Selecting “Other” now will tell the 
computer to use these numbers to convert times.



FT-FR = TIMECODE

Once you have selected the proper film format, these timecodes let 
you synchronize the Foot-Frames display and actual SMPTE time. 
For example, f you want the foot-frame counter to read zero feet at 
a timecode of one hour, just enter 0.00 under Ft-Fr and 
01:00:00:00 under Timecode.

HIDE FRAMES

Checking this box suppresses the display of frames on the screen.

USING SCREEN OPTIONS:
1. Select Screen Options from the Options menu.

2. Select the desired border color and captions style.

3. Select OK to close the dialog box.
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SCREEN OPTIONS
This command allows you to alter the look of the Flying Faders 
VDU for your personal tastes. In no way is automation affected by 
these commands.



AUTOMATE CHANNEL BUTTONS

Note................This feature is for use with Neve consoles equipped
with events.
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Automate Channel Buttons allows you to enable and disable the 
four channel buttons and the cut A/B Bus on any given channel(s).

TO AUTOMATE CHANNEL BUTTONS:
1. Select Automate Channel Buttons from the Options menu

2. Select the button(s) to be automated.

3. Select the channel(s) to be automated.

4. Select OK to return to the main screen.





Transport Menu
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TRANSPORT MENU

The Transporf pull-down menu is found on the menu bar located a t the top of the main Flying Faders screen.

TRANSPORT MENU 7-3



SET LOCATE TIMES
This command allows you to edit the Locate Times. The Locate 
Times are used in conjunction with the Cycle and Locate com­
mands on the main screen, providing an autolocator for the trans­
port.

Note............... The optional transport controller must be interfaced
to use this dialog box.

PLAY FROM

The Play From time is the point in timecode to which the tape 
transport will locate, when the Locate or Cycle command is acti­
vated from the main screen or the keyboard. Times or labels may 
be entered manually or selected from the Label list.

STOP AT

The Stop At time is the point in timecode at which the tape trans­
port will stop during play; and rewind when the Cycle command is 
activated. Times or labels may be entered manually or selected 
from the Label list.

PREROLL

Preroll allows you to apply a fixed offset from the Play From time to 
cause the tape to locate to a point that much earlier. This is useful 
when synchronizing multiple machines.

TO SET LOCATE TIMES:
1. Select Set Locate Times from the Transport menu, or click 

on the Locate Times box on the main screen.

2. Enter the desired timecode in the Play From timecode field.

3. If a countdown to the punch in point is desired, enter the 
time in the Preroll timecode field.

4. Enter the desired timecode in the Stop At timecode field.

5. Select OK to close the dialog box.

Note ...............The Play From or Stop At time may be entered di­
rectly from the main screen by clicking on either time- 
code field or label number field in the Locate Times 
area.
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TO SET LOCATE TIMES FROM THE NEVE V SERIES 
KEYBOARD:

In addition to setting the Locate Times via the Set Locate Times dialog 
box, they may be set directly from the Neve V Series keyboard. Here 
are some examples:

LOCATE 3 PLAY (Press LOCATE, followed by 3, followed by PLAY) 
-Locates to label 3, then plays.

LOCATE (right arrow) 12 12 12 12 PLAY or STOP
-Locates to this timecode (12:12:12:12), then plays or stops.

LOCATE+ 1015 PLAY or STOP
-Locates 10 sec, 15 frames ahead, then plays or stops. A 

backwards locate is done if - is used instead of +.

LOCATE 3 TO 4 PLAY or STOP
-Similar to LOCATE 3 PLAY, but in addition, sets Stop At Point 

(TO Point) to label 4.

LOCATE 3 TO (right arrow) 12 12  12 12 PLAY or STOP
-Locates to label 3 and sets the Stop At time to 12:12:12:12.
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SET ROLLBACK TIME
This command allows you to set a timecode amount which the 
transport will rewind during a Rollback. When the Rollback com­
mand is activated from the main screen or the keyboard, the trans­
port will rewind the preset time and then drop into play.

Note............... The optional transport controller must be interfaced
to use this dialog box.

TO SET ROLLBACK TIME:

1. Select Set Rollback Time from the Transport menu.

2. Enter the desired Rollback Time in the timecode field.

3. Select OK to close the dialog box.
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SET REEL START 
AND END TIMES

This command allows you to inform the system of timecode points 
near the beginning and end of the reel. The system will then pre­
vent the tape from inadvertently rewinding or fast-forwarding past 
these points.

Note................The optional transport controller must be interfaced
to use this dialog box.

TO SET REEL START AND END TIMES:

1. Select Set Reel Start and End Times from the Transport 
menu.

2. Enter the desired time in the Start of Reel timecode field.

3. Enter the desired time in the End of Reel timecode field.

4. Select OK to close the dialog box.
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SET AUTO RECORD TIMES
This command allows you to set points in timecode between which 
the transport will automatically punch in and punch out. This is an 
especially useful command when a tight in and out is required for 
an overdub. When the Auto Record Times are displayed on the 
main screen, Cycle and Locate use these times to perform their 
functions. Clicking on Record or Locate, in the upper right corner 
of the Locate Times area, toggles between Locate Times and Auto 
Record Times.

Note............... The optional transport controller must be interfaced
to use this dialog box.

PREROLL

Upon entering a Record In time, the Locate and Cycle commands 
will play from this point. As a “running start” countdown will likely 
be desired before the punch in point, a time can be entered here to 
specify the length of the countdown.

POSTROLL

Upon entering a Record Out time, the transport will either stop or 
Cycle at this point. As it is generally desired to play through the 
Record Out point, a selectable Postroll is provided.
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TRANSPORT MENU

RECORD VERIFY

During Cycle, with Auto Record enabled, you may not want the 
transport to go into record with each cycle without confirmation 
from you. Choosing Record Verify will allow you to confirm if the 
transport should go into record when the punch in point is reached. 
Confirmation is accomplished by pressing the RECORD button on 
the Neve V Series keyboard while playing through the Record In 
point. If Record is selected, a record command will be issued 
without confirmation when the punch in point is reached.

TO SET AUTO RECORD TIMES:

1. Select Set Auto Record Times from the Transport menu, or 
click on the Auto Record Times area on the main screen.

2. Enter the desired timecode in the Record In timecode field, 
or select the time from the Label list.

3. If Preroll is needed, enter the desired time in the Preroll 
timecode field.

4. Enter the desired timecode in the Record Out timecode 
field, or select the time from the Label list.

5. If Postroll is needed, enter the desired time in the Postroll 
timecode field.

6. Select Record or Record Verify.

7. Select OK to close the dialog box.

Note................The Auto Record times may be updated by clicking
directly on the Record In and Record Out timecode 
fields in the Auto Record area of the main screen.
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AUTO RECORD ON / 
AUTO RECORD OFF

This command allows you to turn Auto Record on and off. When 
enabled, a red and yellow box will appear, telling you that Auto 
Record is on. When the transport is put into play, a countdown 
(part of the preroll) to Record In will be displayed. When the 
transport automatically goes into record, the Auto Record On box 
will turn completely red. A countdown to Record Out will then be 
displayed.

Note ............... The optional transport controller must be interfaced
to use this dialog box.

TO TURN AUTO RECORD ON:
1. Set the Auto Record Times.

2. Press AUTO REC on the Neve V Series keyboard, or select 
Auto Record On from the Transport menu.

3. Place the transport into play.

Note ............... Auto Record will not turn on unless you have al­
ready set the Record In/Record Out times.

TO TURN AUTO RECORD OFF:
1. Press AUTO REC on the Neve V Series keyboard, or select 

Auto Record Off from the Transport menu, or click on the 
Auto Record On box.

SELECT TRANSPORT
This command allows you to select the constants for the tape 
transport to be used with Flying Faders.

Note ............... The optional transport controller must be interfaced
to use this dialog box.

TRANSPORT CONTROL ENABLED

This command determines if the transport will be controlled by the 
Flying Faders transport controller.
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TO SELECT THE TRANSPORT:
1. Select Select Transport from the Transport menu.

2. Select the desired tape machine from the list.

3. Select Transport Control Enabled.

4. Select OK. A dialog box will appear to inform you that the 
constants for the chosen tape machine are set.

5. Select OK to close the dialog box.

6. Select Reset Transport Controller from the Transport 
menu.

RESET TRANSPORT 
CONTROLLER

This command allows you to reset the transport controller without 
performing a total system reset.

Note................The optional transport controller must be interfaced
to use this dialog box.

TO RESET TRANSPORT CONTROLLER:
1. Select Reset Transport Controller from the Transport menu.

2. The transport controller will reset and a dialog box will ap­
pear informing you that the current tape machine constants 
have been set.

3. Select OK to close the dialog box.
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ENABLE TRANSPORT 
CONTROL BUTTONS

The Transport Control buttons on the Flying Faders Main screen 
and console are used to control the transport via the AS2600. If 
your system is set up so that the Transport Control buttons are also 
hard-wired directly to the Transport, you may wish to disable the 
control through the AS2600 to prevent conflicts.

To disable any of the console buttons, uncheck its box. This only 
disables the console buttons; the buttons on the main screen 
remain active.
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Lists Menu
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The ‘Lists' pull-down menu is found on the menu bar located at the top of the main Hying Faders screen.
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LABEL LIST
The Label List allows you to capture a point in timecode and assign 
a number and a name to it. Labels are not a necessity, but a 
convenience for performing system operations. The Label List 
appears throughout the Flying Faders program, providing an alter­
nate method of timecode selection. Labels in the list are arranged 
by their location in timecode, not by their Label number.

NEW

This command allows you to create a label for the point in time- 
code that is displayed in the timecode area of the main screen. 
This is very useful for creating labels on the fly.

TO CREATE A NEW LABEL:
1. Press LABEL on the Neve V Series keyboard, or select 

Label List from the Lists menu, or click on the Labels area 
of the main screen.

2. Select New at the point in timecode that a label is desired.

3. Select OK to close the dialog box.

Note................A new label may be created without opening the
Label List dialog box by pressing NEW LABEL on the Neve V 
Series keyboard. A dialogue box is opened on the main screen for 
the label name. Pressing New Label again automatically creates 
the next label and so on.

MODIFY

This command allows you to edit labels contained in the Label list.

TO MODIFY A LABEL:
1. Press LABEL on the Neve V Series keyboard, or select 

Label List from the Lists menu, or click on the Labels area 
of the main screen.

2. Select the Edit Labels option button.

3. Select the label that you wish to edit. It will appear in the 
Selected Label box.

4. Modify the chosen label. Any part of the label may be ed­
ited.
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5. Select the Modify command button and the label will be 
placed on the list in its proper place in timecode.

6. Select OK to close the dialog box.

Note................ If you decide to cancel a change, be aware of the
fact that CANCEL will erase all changes made from 
the time the Label List dialog box was opened.

DELETE

This command allows you to remove a label from the Label list.

TO DELETE A LABEL:
1. Press LABEL on the Neve V Series keyboard, or select 

Label List from the Lists menu, or click on the Labels area 
of the main screen.

2. Select the Edit Labels option button.

3. Select the label that you wish to delete. It will appear in the 
Selected Label box.

4. Select the Delete command button and the label will be 
removed from the list.

5. Select OK to close the dialog box.

Note................ If you decide to cancel a change, be aware of the
fact that CANCEL will erase all changes made from 
the time the Label List dialog box was opened.
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ADD

This command allows you to manually enter a label number, its 
position in timecode, and to name it.

TO ADD A LABEL:
1. Press LABEL on the Neve V Series keyboard, or select 

Label List from the Lists menu, or click on the Labels area 
of the main screen.

2. Select the Edit Labels option button.

3. Enter the label number in the left text box of the Selected 
Label box. (Labels may not be added without a label num­
ber.) Use Next to automatically use the next available label 
number.

4. Enter the desired timecode in the timecode field.

5. Enter the label name in the right text box of the Selected 
Label box.

6. Select the Add command button.

7. Select OK to close the dialog box.

Note............... If you decide to cancel a change, be aware of the
fact that CANCEL will erase all changes made from 
the time the Label List dialog box was opened.

OTHER COMMANDS

Next-Automatically increments the label number, going to the 
next label on the list.

Delete All-Erases all labels. (Followed by a Yes/No dialog 
box.)

AutoScroll-As tape plays, the highlight bar moves through the 
Label List box, highlighting the labels when their point in time- 
code is reached.
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CAPTURE MARK TIME
Capture Mark Time takes the timecode displayed at the time this 
command is chosen and adds it to the Label list as label number 
zero. This is a very useful “quick label” feature, but be aware of the 
fact that the next time this command is selected, the previous Mark 
label will be overwritten.

TO CAPTURE MARK TIME:
1. Press MARK on the Neve V Series keyboard, or select 

Capture Mark Time from the Lists menu.

2. The timecode that is displayed at the time of selection is 
added to the Label list, along with the Mark title.
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CHANNEL NAMES
This command allows you to assign a name to each of the chan­
nels. Channel names are not a necessity, but a convenience for 
performing system operations. Channel names appear throughout 
the Flying Faders program, providing a convenient way to differen­
tiate channels.

TO NAME A CHANNEL:
1. Select Channel Names from the Lists menu.

2. Select the desired channel.

3. Add to or edit the name in the text box.

4. Select the Name command button to add the name to the 
list.

5. Select OK to close the dialog box.



EVENT LISTS
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The Mute, Channel Button, and the Cut A/B Bus Lists allow you to 
view and edit events for mutes, channel buttons, and the cut A/B 
bus. The list that appears when the box is first opened is deter­
mined by your menu selection. All three lists may not be viewed 
simultaneously, but may be changed via a sub-dialog box or by 
returning to the main menu. Events may be viewed or edited by 
the type of event, the channel on which the event occurred, and/or 
their location in time.

Note...............The Channel Button List is for use with Neve con­
soles that are equipped with events.

SCROLLING THE EVENT LISTS

The buttons directly to the right of the list are used to scroll the list.

B eg .......Displays the beginning of the list
16-.........Moves the list backwards by 16 events
4 - ...........Moves the list backwards by 4 events
4 + ..........Advances the list by 4 events
16+....... Advances the list by 16 events
E nd .......Displays the end of the list

VIEW EVENTS

This box, which is located on the right side of the screen, allows you to 
choose what the event list will display. Events may be viewed on all or 
selected channels. The system default is set to show all channels, but 
any channel(s) may be selected to be displayed. The option button 
labeled On Selected Channels enables the channel selections that 
were made in the Select View sub-dialog box.
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SELECT VIEW

The Select View command button opens a sub-dialog box, 
which is used for choosing channels to be displayed and for 
changing the type of event to be displayed. This dialog box 
may also be used to locate a specific time that an event oc­
curred on.

NEAR THIS TIME

This box allows you to locate an event contained in the list. 
The default time is the current tape location. If a different 
time is desired, it may be entered directly in the timecode 
field or selected from the Label List by choosing Select 
From List.



VIEW THESE EVENTS

This section of the Select View dialog box allows you to 
choose any of the three event lists without having to re­
select them from the main screen menu. The right side of 
the box allows you to select any of the four channel buttons 
for viewing. The View All Channel Buttons command button 
selects all the buttons simultaneously.

ON THESE CHANNELS
This section of the Select View dialog box allows you to 
assign the channels to be displayed for the lists. The Select 
All command button may be chosen to quickly select all 
channels. Channel selections are retained when another list 
is displayed.

CURRENT TIME
The Current Time command button places the event closest to the 
current timecode in the center of the list. Any new events that 
occur while automation is on will also be added to the list with this 
command.

N o te ............Normally the list isn’t updated until automation is
turned off, but the Current Time command adds 
events that are created while tape (timecode) is 
running.
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TIMECODE

This box allows you to edit timecode. This is useful for changing 
the timecode of an existing event, or for adding an event. You may 
select times from the Label List by choosing Select From List, or if 
the desired time doesn’t exist in the Label List, it may be entered 
directly in the timecode field. The Preset Time may be entered in 
this box by pressing 'P\

CHANNEL

This section is for designating the channel on which events or 
event edits will occur. Channels may be chosen by entering the 
channel number directly in the box or by choosing Select, which 
calls up the Channel Names dialog box.

STATUS

This box is used to select the state of an event that is to be added 
or modified. Any given event may be configured to be on or off.

EVENT

This section of the list allows you to choose events for editing. The 
events that are highlighted in this box are the events that are cur­
rently being displayed in the list. Edits may be made to any of the 
events (highlighted or grayed), regardless of the event list that is 
displayed. Any event edit that occurs is immediately updated by 
Flying Faders.

ADD

This command allows you to insert events into the Event Lists.
You may add events to the channel mute, the four channel buttons, 
or to the cut A/B bus. These buttons may be configured to be on or 
off.
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TO ADD TO THE EVENT LISTS:

1. Select the desired event list from the Lists menu (Mute, 
Channel Button, or Cut A/B Bus).

2. Enter the time that you wish the event to occur on in the 
timecode field of the Label box.



TO DELETE FROM THE EVENT LIST:

1. Select the desired event list from the Lists menu (Mute, 
Channel Button, or Cut A/B Bus).
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3. Select or enter the channel number that you want the event 
to be added to from the Channel box. (This step is unnec­
essary if you are adding a cut bus event.)

3. Select the event state from the Status box.

4. Select the desired event to be added from the Event box.

6. Go to the View Events box and select the channel(s) that 
you wish to add events to (so that you can see existing 
events and verify the add).

7. Select Add to insert the event.

8. Select Exit to return to the main screen.

MODIFY

This command allows you to edit items in the Event Lists. Time-
code, channel number, status, and event type may all be changed.

Note...............To change the channel names and the channel
button names, refer to “Channel Names” and 
"Channel Button Names" in this chapter.

TO MODIFY THE EVENT LISTS:

1. Select the desired event list from the Lists menu (Mute, 
Channel Button, or Cut A/B Bus).

2. Select the entry that you wish to modify from the list. The 
Timecode, Channel, Status, and Event boxes will all be 
changed to match the selected entry.

3. Make the desired edits to these boxes.

4. Select Modify to initiate your changes.

5. Select Exit to return to the main screen.

DELETE

This command allows you to remove events from the Event Lists.



2. Select the desired entry or entries from the list. 
(SHIFT+Click and drag to select multiple entries.) Events 
that were previously selected, but no longer shown in the 
window are de-selected.

3. Select Delete and the event will be removed from the Event 
List.

4. Select Exit to return to the main screen.

RELAY SYSTEM
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Flying Faders Version 3.0 supports a new external relay facility.
Up to 128 relays can be automated to control devices external to 
the console. This facility allows you to automate devices from cart 
machines to switch triggered effects to video devices and anything 
else that can be triggered electronically. Control of the devices can 
be either from external panels with 16 relay control buttons per 
panel or from the Select Buttons on the faders via the OTHER 
Mode called “Relay Control”.

GENERAL RELAY OPERATION

Relays can be configured to work in a momentary or latching 
mode. In momentary mode, pressing a relay causes the relay to 
engage and then automatically disengage. Normally momentary 
relays stay engaged for 8 frames although the technical manual 
explains how in the System Initialization File you can change this 
default length. In latching mode, pressing a relay turns the relay to 
its opposite state - if it’s on it will go off and if it’s off it will go on.

Unlike mutes, relays operate on press rather than release. With a 
mute, pressing the mute puts it into “erase” mode and releasing it 
writes the mute. With relays, pressing the relay turns the relay on 
or off, and holding it down does not erase underlying events (see 
Erase Previous feature for more information).



CONTROLLING RELAYS FROM THE CONSOLE

In some cases you may wish to control a relay from the console 
instead of or in addition to a relay control panel. One or more 
channel SELECT buttons can be associated with a relay. Relays 
can be connected with SELECT buttons in the Relay Setup win­
dow under the LISTS menu. To use the SELECT buttons, change 
the Other Key to RELAY CONTROL and press the Other Key to 
enter the mode. The SELECT keys that have been assigned will 
now work in parallel to the relay buttons on relay control panels 
(although relays can be controlled in this way from SELECT but­
tons even if there are no relay control panels).

RELAY EVENTS

RELAY EVENT LIST

The Relay Event List allows you to view and edit events for relays. 
Events may be viewed by the relay, and/or their location in time. 
Any event edit that occurs is immediately updated in the computer.

Note: The Relay Event List is for use with Neve consoles that are 
equipped with Events.

BEG, 16-, 4-, 4+, 16+, END

These commands allow you to scroll through the events in the list. 
The maximum number of events that can be displayed on the 
screen at any one time is sixteen. The button describes the amount 
to scroll; BEG gets you to the beginning of the list, 4+ shows the 
next four events; 16- shows the previous 16 events; and so on. If 
BEG is disabled, you know that you are at the beginning of the 
event list; the same applies to the END button.

TIMECODE

This box informs Flying Faders of the point in timecode that an edit 
is to occur. You may choose the time from the Label list by choos­
ing the Select command button. If the time doesn’t exist in the 
Label list, the timecode may be entered directly by typing it in the 
timecode field of the Label box. The preset time may be entered in 
this box by pressing ‘P’.

8-14 USERS MANUAL - CHAPTER EIGHT



RELAY

This box is for designating the Relay number for the event. The 
Select command button on the far right opens a dialog box that 
contains a list of relay names and numbers. Any relay selected 
from this list will be placed in the Relay box.

STATUS

This box is used to select the state of an event that is to be added 
or modified. The status options depend on the Relay number 
entered in the Relay box. If the Relay is a latching relay, the the 
relay event can be on or off. If the Relay is a momentary, then you 
are only allowed to select the momentary status.

CURRENT TIME

This command allows you to display events that have occurred 
while automation is on. Normally the Relay Event List isn’t updated 
until automation is turned off, but “Current Time” displays the 
events near the current system time, and allows you to update the 
list while tape (timecode) is still running.

To update the Relay Event List, press the Current Time button. If 
any new events have occurred, the list will be adjusted accordingly.

MODIFY

This command allows you to edit items in the Relay Event List. 
Timecode, Relay number, and Status can all be changed.

TO MODIFY THE RELAY EVENT LIST:

1. Select the entry that you wish to modify from the list. The 
Timecode, Relay number, and Status boxes will all be 
changed to match the selected entry.

2. Make the desired edits to these boxes.

3. Select Modify to initiate your changes.
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DELETE

This command allows you to remove events from the Event List.
Any event listing may be deleted, even multiple items may be 
selected for deletion.

TO DELETE FROM THE RELAY EVENT LIST:

1. Select the desired entry(s) from the list. The Timecode, 
Relay, and Status boxes will all be changed to match the 
selected entry.

2. Select Delete and the event(s) will be removed from the 
Event List.

ADD

This command allows you to insert events into the Relay Event 
List.

TO ADD TO THE RELAY EVENT LIST:

1. Enter the time that you wish the event to occur on in the 
timecode field. Press ‘P’ if you wish the Event to occur from 
the preset.

2. Select or enter the relay number of the Relay event you 
want added. If the relay name appears grayed, then you are 
not viewing events for this relay and when you add this 
event, it will not appear in the list.

3. Select the event state from the Status box. Your options will 
depend on whether the relay you selected was a momentary 
of latching relay.

4. Select Add to insert the event.

VIEW OPTIONS

These options let you choose which event you wish to be listed in 
the Event box. To view the event for all relays, select the “On all 
relays” button. To view events for only certain relays:

1. Select the “On selected relays” button.

2. Press the “Select View” button to set which relays to view.
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RELAY SETUP

The Relay Setup dialog box allows you to configure your relays. In 
this box you set the name of the relays, the type of relay, the 
preroll, and which select buttons activate the relay.

MODIFYING A RELAY SETUP

To change the setup for a Relay, first select the Relay to be 
changed from the Relay list. Then make your changes in any of 
the fields and press MODIFY to make the changes. The relay 
information consists of the following:

NAME The name of the Relay.

TYPE You may select whether the relay is a momentary relay or 
a latching relay. You would set this according to the type of 
external device connected to the Relay.
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For more options on which events to view, press the “Select View” 
button.

ERASE PREVIOUS

Since Relays, unlike mutes, are actioned upon the press of the 
button rather than the release, relays do not erase events in the 
play pass while you hold down the relay button (unless of course 
you are in Lock Record). The Erase Previous feature allows you to 
selectively delete relay events.

To begin using the feature (with automation on or off), select Erase 
Previous on the Relay Events List window under the LISTS menu 
or press the Erase Previous button on a relay control panel or 
press the ALL button on the console. All the relays will light solid 
and the current timecode will be noted. Select/deselect relays to 
be edited by pressing the buttons of the appropriate relays. Se­
lected LEDs will flash quickly. Now by unchecking Erase Previous, 
or pressing the Erase Previous button, or pressing ALL you will 
erase the relay event previous to the noted timecode on selected 
channels. The most common use of this feature might be the 
following: You are writing a pass and you press a relay but realize 
you did it too early or late. Engage Erase Previous, press the relay 
you made the mistake on, and disengage Erase Previous. The 
event is removed.



PREROLL
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Some devices take a while to stabilize. For example, a cart ma­
chine may take 10 frames for audio to begin after being started. In 
these cases it would be nice to specify when the sound should 
begin rather than when the relay should be turned on. Flying Fad- 
ers accomodate this with a selective preroli function. For example, 
if we want the cart to begin playing at 01:00:00:20, we need to 
preroll the relay by 10 frames to 01:00:00:10.

For reference we call the physical activation of the relay the “trigger 
time” or the “play time with preroll.” The time when the device 
begins “going” is called the “play time.” The time at which the relay 
is pressed is assumed to be the “play time” not the “trigger time.” 
So, with the cart machine above, if you pressed the relay at 
00:00:10:20, the relay would turn on during subsequent playbacks 
at 00:00:10:10. Since the automation computer doesn’t know when 
you will press a relay, when you first record a relay event, the relay 
will be engaged when you press the relay. On playback, however, 
the relay will engage with the preroll time subtracted (in this cart 
machine exampe, 10 frames earlier).

For latching events, preroll is not applied to 'off' events since nor­
mally, turning off a device happens quickly. When you view relay 
events in the Relay Event List window under the LISTS menu item 
(see EDITING RELAY EVENTS below), the timecodes shown are 
“play times”, not “trigger times.”

USE SELECT BUTTONS ON CHANNELS

When the system is in Relay Control mode (by pressing 
SHIFT+OTHER until “Relay Control” appears on the Main menu 
and then pressing the OTHER key to activate it), pressing the 
select buttons will activate the selected Relays and the Select 
LEDs will indicate the Relay status. Choose from this list box the 
Select buttons that you want to activate this Relay.

SETTING THE RELAY SYSTEM MODE

You can set the Relay System Mode from this dialog box (as well 
as from the console). The Relay System Modes accessible from 
this box are:

RSI

Just like mutes, relays can be in one of 3 modes, Record, Safe or 
Isolate. In Record, relays play back from the current pass and any
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changes become part of the next pass. Relays in Safe play back 
but are not recorded into the new pass. Isolated relays are essen­
tially unautomated. They do not play back events from the current 
pass and they do not record your relay presses.

Unlike mutes, relays do not have their own RECORD buttons.
Thus their RSI mode cannot be changed like mute RSI mode. 
There are two ways to change relay RSI mode. If you have exter­
nal relay panels, press the RSI button. The LEDs will then indicate 
the RSI mode of the associated relay. Blinking means Record, 
solidly lit means Safe, and off means Isolate. Pressing the relay 
button changes the RSI mode (but of course does not activate the 
relay). Pressing the RSI button again will return normal relay op­
eration with the new RSI modes engaged.

If you do not have an external panel you must use channel select 
buttons while in the Other mode called “Relay Control”. Then, from 
the Relay Setup Window, select the RSI checkbox. The Select 
buttons will blink as described above and pressing them will 
change the associated relays’ RSI mode. Deselect RSI in the Relay 
Setup Window to return to normal relay operation with the new RSI 
modes engaged.

RECORD MODE

Just like mutes, relays can be in one of 2 Record modes, Touch 
Record and Lock Record. Unlike mutes, however, in Touch 
Record, relay events will NOT be erased on a particular relay while 
the relay is being pressed. In order to erase relay events you can 
use the Erase Previous feature, the Relay Events List Window, or 
Lock Record. In Lock Record, relay events will be erased on a 
particular channel after the relay is pressed and until automation 
stops.

Unlike mutes, relays do not have their own RECORD buttons.
Thus their Record mode cannot be changed like mute Record 
mode. There are two ways to change relay mode. If you have 
external relay panels, press the Mode button. The LEDs will then 
indicate the Record mode of the associated relay. Solidly lit means 
Lock Record and off means Touch Record. Pressing the relay 
button changes the Record mode (but of course does not activate 
the relay). Pressing the Mode button will return normal relay op­
eration with the new Record modes engaged.

If you do not have an external panel you must use fader Select 
buttons while in the Other mode called “Relay Control”. Then, from 
the Relay Setup Window select the Mode checkbox. The Select



buttons will blink as described above and pressing them will 
change the associated relays’ mode. Deselect Mode in the Relay 
Setup Window to return to normal relay operation with the new 
modes engaged.

DISABLE

Since the Relay buttons on an external panel are used to both 
control the on/off state of relays as well as to set information about 
relays (i.e. RSI and Record mode), it is necessary to be able to 
disable relays so that, for example, pressing a relay to change RSI 
mode does not toggle the relay. In addition, it may be desirable to 
disable relays when during mixing it is a nuisance to have the 
relays engaging and disengaging. Relays are automatically disa­
bled when you select Relay RSI mode, Relay Record mode or 
Erase Previous Relay mode. In addition you can disable it by 
either selecting the Disable button on the external panel or select­
ing the Disable checkbox in the Relay Setup Window.
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Stores are a new feature of Flying Faders in version 3.0. Stores 
allow you to capture the settings of faders, mutes, channel buttons 
and relays and restore those settings at a later time (called ‘Setting 
the Store to the desk’).

Stores can be set while automation is on or off. If automation is on, 
moves are written into the mix to set the store, creating a new

pass.

STORES/PRESENTATION LIST

When the Stores/Presentation list is active on the Main menu, the 
middle store is highlighted. The arrow points towards the next 
store that will be set to the console when activated from the key­
board (button number 2 on the Neve keyboard).

SELECTING A STORE

This command lets you display/hide the Stores box on the main 
screen. The Stores box is a 3 line window into the Stores List or 
Presentation List on the main screen. You may choose to view 
either the Stores List or Presentation List by selecting the 
apropriate button in the caption bar. The Stores Presentation box 
may be selected from the Lists menu, or by pressing S I2 on the 
Neve keyboard. Pressing the button a second time will turn it off.

SHOW STORES/PRESENTATION BOX



SETTING THE DIRECTION ARROW

You may also use the arrow keys to scroll through the list. The 
arrow indicates the direction the list will scroll when the current 
store is Set. If the arrow is pointing up, then when Set Store is 
pressed, the current Store is Set to the desk and the previous 
Store is now the current Store. If you don’t want the list to auto­
matically scroll every time Set Store is pressed, press the right 
arrow key, so that the arrow points to the current Store.
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STORES LIST

TO CREATE A NEW STORE

To create a new store, either press the New Store button (CTRL 
F11) or press the New Store button in the Stores List Window 
(accessible from the Lists Menu). After you create a store, you are 
asked to give the store a name. You can either enter a name or 
just ignore the question (in which case the Store will be given a 
default name).

SET STORE

This command Sets the selected Store to the desk (i.e. adjusts 
faders, mutes, channel events, and relays to match the stored 
settings).

TO SET A STORE

1. From the list box, select the store that you wish to set.

2. Select SET STORE from the dialog box. The selected store 
will be set with the specified glide time.

3. To set a Store from the Stores/Presentation box on the Main 
menu, press button number 2 on the Neve keyboard.

Note: Pressing Set Store on the console will set the next store 
according to the Stores Box, not the Store selected in the Stores 
List.



MODIFY

This command lets you modify existing Stores.

TO MODIFY A STORE:

1. From the list box, select the store(s) that you wish to edit. If 
you have selected more than one store, then the parts of the 
selected stores have in common will appear in the edit 
fields.

2. Modify the chosen store(s). You can Change the Name, 
Glide Time, Include Mask, or Momentary Relays for the 
Store(s)

3. Select the MODIFY command button and the store(s) will be 
placed on the list.

NAME

The name of the store. A store’s name, as well as number, will 
appear in the Stores Box on the main screen.

GLIDE TIME

After a store has been created you can assign it a glide time (which 
by default will be 1 frame). This is the length of time a store will 
take to be set to the desk. In other words, if the glide time is 20 
frames, it will take 20 frames for the faders to glide from where they 
are to their Store positions. In addition, mutes “glide” in a way. 
Mutes that need to be turned on to match the store settings are 
turned on at the start of the glide whereas mutes that are being 
turned off (as well as channel buttons and relays) are turned off at 
the end of the glide.

INCLUDE MASK

When you take a new store, settings of all faders, mutes, channel 
buttons and relays are captured. However, when you set the store 
to the console, you can selectively Set only part of the console 
using Include Masks. Since all the information is always captured, 
you can change the mask as often as you like. For example, you 
could change a mask that included faders and mutes on channels 
1 thru 10 to later include only channel events on faders 15 thru 20.
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You may specify 8 different Include Masks and each snapshot can 
be assigned one of those 8 masks. You can change which Include 
Mask is assigned to a store and you may change the contents of 
each of the 8 masks. Changing the contents of an Include Mask will 
effect how any snapshot that uses that mask will be recalled.

To change which of the 8 Include Masks is assigned to a particular 
snapshot, bring up the Stores List Window from the Lists menu, 
select the store you wish to modify, select the new Include Mask 
you want to use, and press the Modify button.

To change the contents of one of the 8 Include Masks, bring up the 
Stores List Window from the Lists menu, select the Include Mask 
you wish to modify, and then press the Edit Mask button. A mask 
editing window will appear that allows you to change the mask’s 
name and what it includes i.e. which channels to include and which 
categories of settings. The categories are faders, mutes, and each 
of the different channel buttons. In addition, you can select which 
relays should be included in the ‘sets’ using this Include Mask.
After you have made the desired changes, press the OK button.

TO EDIT AN INCLUDE MASK

Editing an Include Mask is as simple as making the desired 
changes in the option boxes and pressing OK.

NAME

You may change the name of the Include Mask by typing in the 
new name here.

INCLUDE THESE EVENTS

These options specify which events are to be included when the 
Store is set. You may include Faders, Mutes, or any of the Channel 
Buttons.

ON CHANNELS

Only the events for the channels selected in this box will be in­
cluded.
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INCLUDE THESE RELAYS

You may choose which relays are to be included. Note that if a 
Store has momentary relays, the momentary relays will not go off 
unless they are also included in the Include Mask.

MOMENTARY RELAYS

Since momentary relays are only on for a brief moment. Stores 
ignore momentary relays when examining the console during the 
‘New Store’ operation. If you wish a momentary relay to be acti­
vated when a store is set to the desk you can specify it in the 
Stores List Window (accessible from the Lists Menu). Select the 
store you wish to modify. Select the momentary relays you want to 
be activated as part of the selected store. Press the modify button 
and the store will be changed.

DELETE

This command lets you delete selected Stores.

TO DELETE A STORE:

1. Select the store(s) that you wish to delete.

2. Select the DELETE command button and the store(s) will be 
removed from the list.

COPY

This command lets you make a duplicate copy of an existing store.

TO COPY A STORE:

1. Select the store that you wish to duplicate.

2. Select the COPY command button and a copy of the se­
lected store will be created. The focus is placed on the edit 
box so that you may edit the name or any other part of the 
new store.
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RIPPLE LIST

Selecting RIPPLE renumbers the stores. If you had stores num­
bered 3,4,5,6,8,25 and hit RIPPLE, then the stores would be num­
bered 1,2,3,4,5,6 respectively. Nothing else about the stores is 
changed.

HOLDTOUCH

After setting a store to the desk, normally, play pass moves con­
tinue to play, including any offset imposed by the store. If you wish 
for the recalled settings to be absolute, not immediately following 
moves dictated by the play/pass, you should enable the Hold 
Touch feature. This makes all modified items act as if they are 
being “touched” after they are matched, somewhat like the Master 
Touch feature. Moves underneath are overwritten until automation 
is turned off or until the Hold Touch option is deselected.

Selecting either Local or Global Match will drop the respective 
faders out of Hold Touch and match them to the play pass position.

To enable the Hold Touch feature, select ‘Hold Touch’ in the Stores 
List Window (accessible from the Lists Menu) or press the Hold 
Touch button on the main screen’s Stores Box.
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PRESENTATION LIST

The Presentation List allows you to specify a “setting order” for 
Stores. For example, let’s say our first 3 stores are named “Verse 
1”, “Chorus” and “Verse 2”. If our song goes Verse 1, Chorus, 
Verse 2, Chorus, we might want a presentation list to set the stores 
in the order 1,2, 3,2. To do this we first bring up the Presentation 
List Window under the Lists Menu. By selecting Stores and using 
append, insert, and delete we can build a customized list of stores. 
The presentation list, of course, does not modify the stores in any 
way - it just allows us to set them in a predefined order.

After you have defined a “setting order” in the presentation list, 
press OK. Using the main screen’s Stores Box selected for the 
presentation list, along with the console’s “Set Store” button 
(number 2 on the Neve keyboard) you can step through the pres­
entation list while automation is either on or off.



EDITING THE PRESENTATION LIST

The Presentation List window lets you create and edit the
Presentaion list.

APPEND

To Append Stores to the end of the Presentation List:

1. Select the stores from the Stores List that you wish to be 
appended to the Presentation List.

2. Press Append to append these stores to the Presentation 
List.

The Stores are appended in the order that they appear in the
Stores List (numerical order). That is, if you select Stores 5, 10, 3,
and 15 and press Append, then the Stores will be appended in the
order: 3, 5, 10, 15.

INSERT

To Insert Stores into the middle of the Presentation List:

1. Select the stores from the Stores List that you wish to be 
inserted into the Presentation List.

2. Select the item in the Presentation List that you want the 
Stores to be inserted BEFORE.

3. Press Insert to insert the Stores in the Presentation List 
before the selected item.

DELETE

To Delete items from the Presentation List:

1. Select the items you want to be deleted from the Presenta­
tion List.

2. Press Delete to delete these items from the Presentation 
List.

8-26 USERS MANUAL - CHAPTER EIGHT



RENAME

To Rename an item in the Presentation List:

1. Select the item you wish to rename from the Presentation 
list.

2. Edit the name of the item.

3. Press Rename to rename the item.

Note that when a Store is added to the Presentation List, the name 
of the Store is copied into the Presentation List. If you rename a 
Presentation List item, the name of the Store that the item refers to 
is NOT changed.

LISTS MENU 8-27





Gangs Menu



9-2 USERS MANUAL - CHAPTER NINE



GANGS MENU

The 'Gangs' pull-down menu is found on the menu bar located a t the top of the main Flying Faders screen.
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COALESCE GROUPS
Coalesce Groups allows you to copy all of the moves and mutes of 
a Group master to that master’s slaves, creating a new Mix/Pass. 
The slave’s moves and mutes in the resultant Mix/Pass are the 
sum of their recorded moves plus the moves of the slave’s previ­
ous master.

Note...............Since Coalesced Groups are disbanded, the slaves
in previous Mix/Passes will only play back data that 
was recorded on their individual channels.

MASTERS

This area of the dialog box allows you to assign the Group(s) to be 
Coalesced by choosing its Group master.

COALESCE CHANNEL DATA

This section allows you to choose whether or not subgroups are to 
be Coalesced along with the subgroup’s master. If Group masters 
are Coalesced, but not their submasters, the submaster’s Group 
structure will remain intact, continuing to follow the moves of the 
Group that was Coalesced.

Note...............If you wish to Coalesce specific subgroups in a
Group, but not others, choose “from selected mas­
ters ONLY’ and highlight the desired submasters 
along with their master.
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TO COALESCE GROUPS:
1. Select Coalesce Groups from the Gangs menu.

2. Select the desired Group masters from the Masters box.

3. Select the data to be Coalesced from the Coalesce Channel 
Data box.

4. Select the Coalesce command button and a new Mix/Pass 
will be created, containing the new information.

5. A notice box will appear, informing you of the new Mix/Pass 
that was created.
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SUSPEND GROUPS
This command allows you to temporarily disable all Groups. This is 
most useful when you need to Trim a Group master without Trim­
ming that master’s slaves.

TO SUSPEND GROUPS:
1. Select Suspend Groups from the Gangs menu. A notice box 

will appear, informing you that Groups have been sus­
pended. A check will also appear in front of the Suspend 
menu listing.

2. Make desired adjustments to the fader levels.

3. Select Suspend Groups from the Gangs menu once again.
A notice box will appear, informing you that Groups have 
been enabled.

Note................Groups may also be Suspended from the Trim
Faders dialog box. Refer to Chapter 5, “Trim Fad- 
ers”, for more information.



REMOVE ALL LINKS
This command allows you to delete all Links currently in use.

TO CLEAR LINKS:
1. Select Clear Links from the Gangs menu.

2. A dialog box will appear asking to verify your request.

3. Selecting OK will clear all Links and close the dialog box.

9-6 USERS MANUAL - CHAPTER NINE

REMOVE ALL GROUPS
This command allows you to delete all Groups currently in use.

TO CLEAR GROUPS:
1. Select Clear Groups from the Gangs menu.

2. A dialog box will appear asking to verify your request.

3. Selecting OK will clear all Groups and close the dialog box.

REMOVE ALL GROUPS 
AND LINKS

This command allows you to delete all Groups and Links in use at 
the same time.

TO CLEAR GROUPS AND LINKS:
1. Select Clear Goups and Links from the Gangs menu.

2. A dialog box will appear asking you to verify your request.

3. Selecting OK will clear all Groups and Links and close the 
dialog box.



CLEAR SELECTED GROUPS
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This dialog box allows to to clear selected groups. This is espe­
cially useful when you have phantom faders that are group mas­
ters, because there is no way to remove groups from these faders 
using the GROUP button on the console.

TO CLEAR GROUPS:

1. Select the masters of the groups you wish to be cleared.

2. Press OK.

Only the groups whose masters are selected are cleared. Any 
submasters, if they are not selected, are not cleared.

IMPROTANT... Removing groups ONLY removes the group. This 
means that the removed masters moves will no longer be written to 
its slaves (becuase it will have no slaves). If you wish to remove 
the group AND also write the moves of the master to the slaves, do 
a GROUP COALESCE.

CLEAR SELECTED LINKS

This dialog box allows you to clear selected Links. This is espe­
cially useful when you have phantom faders that members of links, 
because there is no way to remove these faders from links using 
the LINK button on the console.

TO CLEAR LINKS:

1. Select the links that you wish to be cleared by selecting a 
channel in those links. Only channels that are members of 
links will appear in the list box.

2. Press OK.

IMPORTANT... Selecting a channel from the list box will remove 
the ENTIRE link that the channel is a member of. For example, if 
channels 1, 2, 3, and 4 are linked, and you select channel 1 and 
press OK, then the entire link is removed, in other words, even 
though only channel 1 was selected, channels 2, 3, and 4 are also 
unlinked.



MASTER TOUCH

The Master Touch function allows you to make Flying Faders 
always record fader and mute positions selectively from any point 
in the mix/pass. If you position faders and mutes, turn on Master 
Touch, and then start automation, the system will record the new 
positions at the time when automation begins - as if you were 
touching all of the faders. While automation is running, play pass 
moves are being overwritten. Even though Master Touch simu­
lates the faders being touched, faders will still move if reposi­
tioned by a link move, group move, or 'Stores' snapshot set.

SET MASTER TOUCH

This menu command allows the operator to select which faders 
and mutes will be addressed by the Master Touch feature.

The Set Master Touch dialogue box may be selected from the 
Gangs menu, or via the Other key.

Using the fader and mute record buttons you can include or 
exclude individual faders and mutes. If the record light is lit, it will 
be “Master Touched” and if unlit, it will not be. The select light on 
a channel is lit if either its mute or fader is selected. (See 
OTHER mode).

MASTER TOUCH ISOLATE

Master Touch Isolate puts all selected faders and mutes into 
Isolate mode prior to the Master Touch feature being engaged.

As soon as Master Touch is engaged, all selected faders and 
mutes leave Isolate and enter a Record mode. When Master 
Touch is deselected, the faders/mutes will return to their original 
state.

The purpose of this feature is to allow you to run automation and 
adjust the selected faders/mutes whilst listening to tape (together 
with fader/mute automation moves on other channels that were 
not selected). At the point where you want the new balance to 
be engaged, switch on Master Touch and the appropriate moves 
will be written into a new mix/pass from that moment on.

Selected faders/mutes will return to their original state when 
automation is stopped, either by stopping the tape or deselecting 
Master Touch.
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Alternatively, selecting Match on individual faders, or the Global 
Master, will drop the respective faders out of Master Touch and 
Match those faders to the play/pass position.

TO OPERATE MASTER TOUCH

To Select Faders/Mutes for Master Touch

1. Select Shift+Other until Master Touch is selected on the 
main screen.

2. Press Other and select faders/mutes to be engaged by 
Master Touch by pressing their respective Record buttons.

Global Master Record/Mute buttons will select all faders/mutes for 
Touch Record.

WARNING: If more than 48 channels are selected for Touch 
Record simultaneously, a system overload may occur.

Momentary

The Toggle switch positioned at the top of the Global Master mod­
ule is the Master Record button.

Pressing this switch before or after automation is running will simul­
taneously switch all faders/mutes that have been previously se­
lected into Record.

When automation is stopped these faders/mutes will automatically 
drop out of Record and return to their original states.

Latching

Pressing Shift + the Master Record button simultaneously will Latch 
the Master Record button on and will switch all faders/mutes that 
have been previously selected into Record.

When automation is stopped, these faders/mutes will remain in 
Touch.

Pressing the Record button again will unlatch the Master Record 
button and the selected faders/mutes will return to their original 
states.



TO OPERATE MASTER TOUCH ISOLATE

Select the “Master Touch Isolate” dialogue box on the main screen.

This will temporarily switch all faders/mutes that have been pre­
selected for master touch into “Isolate” .

A new mix structure can now be applied to those channels without 
affecting the underlying mix pass moves.

Pressing the Master Record button will switch the selected faders/ 
mutes from Isolate to Lock Record. The Master Record button may be 
pressed either before automation starts, or at any time the mix pass 
is playing.

Stopping automation or toggling the master record button to off will 
return the selected faders/mutes to there original state.

Alternatively pressing either local or Global Match buttons will match 
the respective faders to there play pass position

The Master Touch Isolate function is automatically switched off when 
automation stops.
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SELECT FADERS FOR GLOBAL SOLO
This menu command is a quick way to set the system into Set 
Global Solo Banks mode, allowing you to select which faders will 
participate in Global Solo. See Chapter 2 for more information 
about Global Solo.

TO SELECT FADERS FOR GLOBAL SOLO

1. Select Faders For Global Solo from the Gangs menu.

2. Use the Select buttons on the faders to Select which faders 
will participate in Global Solo. (See the description of Solo 
Mode in Chapter 2)

3. Press OK on the dialog box, or press OTHER on the Global 
Master to close the dialog box.
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SELECT FADERS FOR MULTI SOLO
This menu command is a quick way to set the system into Set Multi 
Solo Banks mode, allowing you to select which faders will partici­
pate in Multi Solo. See Chapter 2 for more information about Multi- 
Man Solo.

TO SELECT FADERS FOR MULTI SOLO

1. Select Faders For Multi Solo from the Gangs menu.

2. Use the Select buttons on the faders to set up the Multi Solo 
Banks. (See the description of Solo Mode in Chapter 2)

3. Press OK on the dialog box, or press OTHER on the Global 
Master to close the dialog box.

CLEAR MULTI SOLO BANKS
This command allows you to delete all the Multi Solo Banks in use.

TO CLEAR MULTI SOLO BANKS

1. Select Clear Multi Solo Banks from the Gangs Menu.

2. A dialog box will appear asking you to verify your request.

3. Selecting OK will clear the Multi Solo banks from memory.
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DISK MENU

The "Disk" pull-down menu is found on the menu bar located a t the top o f the main Flying Faders screen.
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NAME MIX DISK
This command allows you to give a unique name to each disk. The 
disk name will appear in the Disk box of the Keep, Load, and De­
lete dialog boxes. This provides a way to verify that mixes are 
being Kept to, Loaded from, or Deleted from the correct disk. It 
can also be used to differentiate between original disks and backup 
copies, etc.

TO NAME A MIX DISK

1. Select Name Mix Disk from the System menu.

2. Select the disk to be named (Hard or Floppy Disk).

3. Type the name to be used into the Mix Disk Name box.

4. Select OK to close the dialog box
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FORMAT DISK
This command formats a floppy disk placed in the A: drive. It re­
moves all the information on the disk and prepares it for use. A 
formatted disk is needed to keep mixes for archival purposes or for 
carrying mixes out to another Flying Faders facility.

TO FORMAT A FLOPPY DISK:

1. A dialog box tells you what format does and asks you to 
confirm your choice. Select No if you wish to quit.

2. If you select Yes the screen will go blank and you will be 
asked to insert your floppy disk in drive a: if you have not 
already done so, and then press enter to start the formatting 
process.

3. Your disk will now be formatted.

4. A message will appear on the screen letting you know if the 
format was sucessful and asking if you wish to format any 
more disks.

5. If you have finished formatting disks press ‘n’ then enter... or 
if you want to format another press y  then enter.
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COPY MIXES
This feature allows the user to make a duplicate copy of mix infor­
mation. You can copy from your hard disk to a floppy disk or from a 
floppy disk to your hard disk. In addition you can make duplicate 
copies from your hard disk to different names on your hard disk. 
This is useful for backing up work that you have done or for restor­
ing information from a floppy disk that you have previously re 
moved because you thought that you had finished with it. Its major 
benifits over the Backup Mixes and Restore Mixes facilities are that 
you can backup selected mixes, you do not have to backup all of 
your mixes, and that when you restore them the existing mixes on 
the destination disk are not affected, they remain unaltered.

TO COPY MIX INFORMATION:

1. Select the disk that contains the mixes that you wish to 
copy.

2. Select the Client command button. The list of clients will 
appear in the list box.

3. Select the desired client from the list.

4. Repeat steps 2 and 3 to obtain the desired project, title, and 
mix names. Hint: If you double click on your choice from
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the list, it will be placed in the text box and the next list will 
show up.

5. Note that you can just select a client or a project etc. and all 
the mixes under that client or project will be copied.

6. You are also allowed to select multiple clients, projects, titles 
or mixes. To do this click on the first client ( or title e tc.) that 
you wish to copy and then holding the shift key down click 
on the next client that you wish to copy. In this way up to 20 
clients, projects, titles or mixes can be selected at once. 
However remember that if you are copying to floppy you are 
limited by the amount of space on the disk. If you select 
multiple items to copy from you cannot then select at lower 
levels, for instance if you select three clients you can not 
then select one title from one of them. All the projects, titles 
and mixes for those three clients will be copied.

7. Select Continue once you are sure of your choice.

8. On the Copy To page select the copy destination disk (usu­
ally the opposite of your source disk).

9. You may look through the clients, projects, titles and mixes 
that you have chosen to copy by using the Client, Project, 
Title and Mix buttons.

10. You will notice that the highlighted name appears in a box 
with the text “Name:” next to it. If you want to change the 
name of any of the clients, projects, titles and mixes that you 
are copying you can type a new name in here and by press­
ing the Change Name button the old name will be replaced 
with the new name.

11. Similarly if you wish to change the mix notes for any of the 
mixes you are copying you can type new mix notes into the 
“Mix Notes:” box and then press the (Change Name and 
Notes) button.

12. Note that for both renaming and new notes the alteration will 
only be made to the duplicate copy and NOT the original 
which will remain untouched. The alteration will also only be 
made if you select the Rename and New Notes buttons and 
then Copy, if you Cancel then no copying will be performed.

13. Select Copy and the mix information will be copied with any 
alterations that you have made.

DISK MENU 10-7



TRANSFER MIXES
This feature transfers mix information from your hard disk to your 
floppy disk.

WARNING: The information will no longer be on your hard disk. 
This is useful for archiving work that you have finished with. The 
information can be copied back (using Copy Mixes) from the floppy 
disk at a later date if you need to re-mix it.

TO TRANSFER MIX INFORMATION:
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1. Insert a formatted disk in disk drive a: (to format a disk see 
Disk, Format Disk)

2. Select Transfer Mixes from under the Disk menu item.

3. A dialog box asks you which mix information you wish to 
transfer.

4. Select the Client command button. The list of clients will 
appear in the list box.

5. Select the desired client from the list.

6. Repeat steps 2 and 3 to obtain the desired project, title, and



mix names. Hint: If you double click on your choice from 
the list, it will be placed in the text box and the next list will 
show up.

7. Select “Transfer” to transfer your mix from hard disk to 
floppy disk.

8. A dialog box will appear asking you to confirm your choice.
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BACKUP MIXES
This feature backs up mixes from your hard disk to your floppy 
disk. All the mixes on either your C drive (20 Mb systems ) or your 
D drive ( 40Mb systems) will be copied to floppy disk. You will need 
to have enough formatted blank floppy disks to copy all your mixes 
to before you start this process. This is useful for occassionally 
backing up your system in case of hard disk failure. The only way 
to copy this information back is to use the Restore Mixes facility 
and this will destroy any mixes that already exist on your hard disk.

To copy selected mixes to floppy and back to your hard disk with­
out destroying mix data already on your disk, use the Copy Mixes 
facility.



TO BACKUP ALL MIXES:

1. Read the information displayed carefully.

2. Ensure you have a supply of formatted floppy disks.

3. Select Cancel if you wish to quit and use Format to format 
some more disks for this process.

4. Select Continue to backup all mixes from you hard disk.

5. The screen will go black and you will see the mixes being 
transfered. You will be prompted for new disks as they are 
required.

BACKUP SPECIAL FILES

This feature backs up special files from your hard disk to your 
floppy disk. It backs up the System Initialization file, the Transport 
Controller Constants, calibration data, the default transport and the 
default screen setup.

These files can later be restored to your hard disk using Restore 
Special Files, however this will overwrite the existing files on your 
hard disk.
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1. Read the information displayed carefully.

2. Insert a formatted floppy disk in drive a:.

3. If you do not have a disk, select Cancel to quit and use 
Format to format a disk for this process.

4. Select Continue to backup the special files.

5. The screen will go black and you will see the files being 
transfered.

TO BACKUP SPECIAL FILES:

RESTORE MIXES
This feature restores mixes from floppy disk to your hard disk. The 
mixes must have been backed up to floppy using the Backup Mixes 
facility. The mixes will be restored from the floppy disks to either 
your C drive (20Mb systems) or your D drive (40Mb systems). You 
will need all the floppy disks that you backed up your mixes to. This 
is useful for restoring your hard disk, after a failure, with your last 
backup. Any mixes on your hard disk will be destroyed by the 
restore and overwritten with the ones from the floppy disks.
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TO RESTORE ALL MIXES:

1. Read the information displayed carefully.

2. Ensure you have all the floppy disks containing your backed 
up mixes.

3. Select Cancel if you wish to quit.

4. Select Continue to restore all mixes from the floppy disks to 
the hard disk.

5. The screen will go black and you will see the mixes being 
transfered. You will be prompted for the next floppy disk as 
required.

RESTORE SPECIAL FILES

This feature restores special files to your hard disk from your floppy 
disk. It restores the System Initialization file, the Transport Control­
ler Constants, calibration data, the default transport and the default 
screen setup. WARNING: this will overwrite the existing special 
files on your hard disk.
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TO RESTORE SPECIAL FILES:

1. Read the information displayed carefully.

2. Insert the floppy disk containing the backup of your special 
files (produced by using Backup Special Files) in drive a:.

3. Select Continue to restore the special files.

4. The screen will go black and you will see the files being 
transfered.
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HELP MENU

The "Help!1 pull-down menu is found on the menu bar located at the top of the main Flying Faders screen.
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UNDO
This command allows you to reverse commands, including Undo 
itself. Undo restores a dialog box to its former state before it was 
opened, deleting any edits that were made from the time that the 
dialog box was first opened. Undo does not effect mix edits, how­
ever. Refer to the following list for dialog boxes that Undo can 
restore.

DIALOG BOXES AFFECTED BY UNDO:
Client Information 
Select Mix/Pass 
Glide Times 
Timecode Options 
Safety Net Times 
Locate Times 
Rollback
Reel Start and End Times 
Auto Record Times 
Channel Names

TO UNDO A DIALOG BOX:
1. Select Undo from the Help menu. If the dialog box can be 

restored by Undo, its name will follow Undo in the menu 
listing.

2. The dialog box will be restored. If Undo will not work on that 
particular dialog box, a message will appear informing you 
that there is no Undo information. Select OK to close the 
dialog box.
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GENERAL INFORMATION
This command allows you to view a list of Flying Fader topics for 
which help is available. Help on these topics may be obtained by 
selecting the appropriate title from the list.

TO SELECT GENERAL INFORMATION:
1. Press HELP on the Neve V Series keyboard, or select Gen­

eral Info from the Help menu.

2. Highlight the desired title and select the Help command 
button, or double click directly on the title.

3. The Help window will open, containing information on that 
particular topic.

4. Click anywhere on the Help window to close it.
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HELP WITH MENUS
This command opens and closes the Help window. Each time a 
command is highlighted or chosen, facts and instructions about 
that command are displayed in this window.

HIDE HELP WINDOW

1. Select Hide Help Window from the Help menu, or click 
directly on the blue text area of the window.

RESIZING AND MOVING THE HELP WINDOW

The Help window appears at the bottom of the screen when 
opened, but it may be resized and relocated to any area of the 
screen.
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This command allows you to conceal the Help window. Hide Help 
Window does not close the window permanently, but simply masks 
it until a new command is chosen or highlighted.

TO HIDE THE HELP WINDOW:

TO RESIZE THE HELP WINDOW:

1. Position the pointer over the border you wish to move.

2. When the pointer turns into a double-headed arrow, Click 
and Drag the border to the desired location.

TO OPEN THE HELP WINDOW:
1. Select Help With Menus from the Help menu.

2. The window will open and a check will appear in front of the 
command, indicating that the window is enabled.

TO CLOSE THE HELP WINDOW:
1. Select Help With Menus from the Help menu.

2. The window will close and the check by the command will 
disappear, indicating that the Help window is disabled.



TO MOVE THE HELP WINDOW:
1. Position the pointer in the white area containing the Help 

Menu title.

2. Click and Drag the window to the desired location.
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Accelerator keys ..... . Special keys that execute a command or open a dialog box without 
using the menu, the mouse, or a series of keystrokes.

Arrow......................... . A pointer shape that is used for the selection of functions.

Auto M atch............... . When the fader automatically moves back to its original Pass position 
after a change was made to the fader. Auto Match Glide times are 
adjustable.

Check box................. . Small squares that are used to select one or more options in a dialog 
box.

Click........................... .To press and release the mouse button.

Command.................. . A word or phrase, usually found in a menu, that is chosen to carry out 
an action.

Command button.... . Rectangular buttons with rounded corners that are used to activate or 
cancel a command.

Control box............... .The small boxthat is located in the upper left corner of the main screen.

Default....................... .An option or command that is automatically chosen by the system. 
The default can be overridden by selecting the desired command or 
option.

Delete........................ .To erase mix information from a floppy or the hard disk, or remove a 
Label from a list, mutes from a list, etc..

Diagnostics window.,. This window bypasses the Windows environment so you can commu­
nicate directly with the PC.

Dialog box................. .A  box that appears when more information is needed before a 
command can be carried out.

Direct window 
access....................... .Control of commands and features from the main Flying Faders

screen as opposed to opening a dialog box.

D O S........................... . Disk operating system.

Double click.............. . Quickly click the mouse button twice.

Drag........................... .To click and hold the mouse button while moving the mouse.
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Neve V Series 
keyboard .................. The computer keyboard that is installed on Neve consoles. It is 

basically the same as the standard keyboard, but contains pre-labeled 
accelerator keys and transport control keys.

Option button........... A circular button that is used to select an option in a dialog box.

Pointer arrow ........... . A small symbol that indicates what part of the screen will be affected 
when the pointer button is clicked.
it. jiY* ’ If

Preset........................ . An initial snapshot of all fader positions and mute states.

RAM .......................... . random access memory

Ready mode............. . Faders and mutes that are in the Ready Record mode will play back 
and record all moves or mutes when automation is on.

Record Lock............. . A fader and mute Ready mode.

Rollback................... . When activated, the transport will rewind a user-selectable rewind 
time and transfer into play.

RSI............................. . Ready/Safe/lsolate (See individual definitions for each.)

Safe m ode................ . Moves and events are played back, but no moves or events can be 
recorded.

Safety Nets............... . Allows you to make changes between two points in timecode while the 
rest of the mix is placed in Safe.

Scroll bar.................. . A barthat appears atthe right side and/or bottom of a window or dialog 
box that contains arrows on both ends. The scroll bar allows you to 
view text or items that will not fit in the box.

Select........................ . To perform an action that activates a command.

Smart keys............... . User-programmable keys. A command or series of commands may 
be recorded and assigned to one of 12 Smart keys.

Standard keyboard.. . The standard QWERTY keyboard for Flying Faders. Replaced with 
the Neve keyboard.

Text box.................... . Where information is inserted by the user. Text boxes are usually 
located in dialog boxes.
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Text pages.............. ... A word processor in Flying Faders that is used for editing files and for
Si

Timecode field........

making general notes.

... The area that contains timecode numbers.

Touch Record ....... . A fader and mute Ready mode.

Trim ......................... ...To change the preset of a fader or faders.

Two-headed arrow .
si. lio

... A pointer shape that is used for changing the size of the windows.

VDU...... ...................
!i t  iitini "•

...video display unit

xFade.......................
‘ .ti f iOC:

... Crossfade
iP:
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